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Safety Guidelines 

Qualified Personnel 

Correct Usage 

Trademarks 

This manual contains notices which you should observe to ensure your own personal safety, as well as to 
protect the product and connected equipment. These notices are highlighted in the manual by a warning 
triangle and are marked as follows according to the level of danger: 

Danger 

indicates that death, severe personal injury or substantial property damage will result if proper precautions are 
not taken. 

Warning 

indicates that death, severe personal injury or substantial property damage can resutt if proper precautions are 
not taken. 

Caution 

indicates that minor personal injury or property damage can result if proper precautions are not taken. 

Note 

draws your attention to particularly important information on the product, handling the product, or to a particular 
part of the documentation. 

The device/system may only be set up and operated in conjunction wtth this manual. 

Only qualified personnel should be allowed to install and work on this equipment. Qualified persons are 
defined as persons who are authorized to commission, to ground, and to tag circuits, equipment, and sys­
tems in accordance wtth established safety practices and standards. 

Note the following: 

Warning 

This device and its components may only be used for the applications described in the catalog or the technical 
description, and only in connection with devices or components from other manufacturers which have been 
approved or recommended by Siemens. 

This product can only function correctly and safely if it is transported, stored, set up, and installed correctly, and 
operated and maintained as recommended. 

SIMA TIC® and SINEC® are registered trademarks of SIEMENS AG. 

Third parties using for their own purposes any other names in this document which refer to 
trademarks might infringe upon the rights of the trademark owners. 

Copyright © Siemens AG 1997 All rights reserved Disclaimer of Liability 

The reproduction, transmission or use of this document or its contents is 
not permitted without express written authority. Offenders will be liable for 
damages. All rights, including rights created by patentgrantor registration 
of a utility model or design, are reserved. 

SiemensAG 
Automation Group 
Industrial Automation Systems 
Postfach 4848, D-90327 Niirnberg 

Siemens Aktiengesellschaft 

We have checked the contents of this manual for agreement with the 
hardware and software described. Since deviations cannot be precluded 
entirely, we cannot guarantee full agreement. However, the data in this 
manual are reviewed regularly and any necessary corrections included in 
subsequent editions. Suggestions for improvement are welcomed. 

© Siemens AG 1997 
Technical data subject to change. 
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Preface 

Aim of this manual 

Who should read 
this manual? 

Validity 

This manual will help you to configure your control system with respect to 
the equipment contained in the plant, independently of the individual phases. 
It will provide an overview of the various views (plant and device-oriented), 
the individual engineering phases, how to configure your plant and how to 
create templates. You will also find detailed information on: 

• working with the Plant Hierarchy (PH) 

• working with the Import/Export Assistant (lEA) 

• PLC and OS-independent configuration 

The "PH I lEA" software for the SIMATIC S7 process logic control 
incorporates the latest advances in ergonomic design. The software is 
operated via SIMATIC Manager. It is also easy to learn and largely 
self-explanatory. 

As each procedure is explained, you will also see the corresponding menu 
commands. However, there are no instructions on how to complete the dialog 
boxes, since this information should ideally be found in the on-line help and 
not in a manual. 

This manual is aimed at anyone working in the areas of configuration, 
commissioning and servicing. 
They must, however, be used to working with a PC/PG and be familiar with 
Windows95. 

This manual is valid for the engineering toolset in conjunction with the 
descriptions of the "Plant Hierarchy (PH)" and "Import/Export Assistant 
(lEA)" software components from the "PCS 7 engineering options". 
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Preface 

Position within the 
available 
documentation 

Standard software 
for S7 and M7 
STEP? 

User 
manual 

/231/ i� 

v 

System Software for 
S7-300 and S7/400 
Program Design 

S mbol 

There is a considerable amount of User Documentation available to help you to 
plan, configure and program your S7 process logic control. This documentation 
should be used selectively. The following passages together with the illustration 
below are intended to facilitate use of the user documentation. 

SIMATIC 
Process Control System PCS 7 

ES 
manual 

System 
over­
view 

/261/ 
v 

/256 
......___� v 

Manuals for 
configuring tools 

ZB\\r% ''"''F" 
CFC ' CFC 

Manual Manual 
Basic part S7 /M7 

system 

/254/ /254/' 

Manuals for the language packages 

Meaning 

> 

Automating 
Batch Processes 

BATCH 
flexible 
manual 

/257/ 

.... _,.. . ...,_..,""(M-..:�, : r� ! Reference [ 
:manual !� 
i /235/ �; t __________ ,! 

Manuals for 
WinCC software 
and hardware 

Manual 
for the 
PROFIBUS 
bus system 

Manuals for 
87-400 hardware 

Manual r-
-

/100/ 
System Software for S7-300 and S7/400 
System and Standard Functions 

I 11011 
I 11021 

Manuals for the 
distributed peripherals 

ET200M _ 

D This documentation acts as an introduction to the methodology. /140/ 

D 
/xxx/: 

iv 

These are works of reference and therefore only to be used selectively. 

The documentation is supplemented by on-line help. 

Reference number in the bibliography > The order indicated here 

I /141 

is a suggestion for someone using an 87 for the first time. 
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Preface 

Title Contents 

Programming Manual The Programming Manual provides basic knowledge of the structure of the operating 
Program Design system and user programs running on an S7-CPU. It will provide anyone using an 

57-300/400 for the first time with an overview of the programming methods involved. 
This knowledge can then be put to good effect when designing the user program. 

STEP 7 User Manual The STEP 7 User Manual explains the fundamentals and functions of the STEP 7 pro-
gramming software. The manual provides you, as a new user of STEP 7 and an experien-
ced user of STEP 5, with an overview of the procedures of configuring, programming 
and commissioning an S7-300/400. 

While you are using the software, you can call up the on-line help. This will give you 
detailed answers to questions associated with the software application. 

STL, LAD, FBD, SCL The manuals for the STL, LAD, FBD and SCL language modules contain both a user's 
Manuals guide and a description of the language. 

While you are using the software, you can use the on-line help to answer all your detailed 
questions on use of the associated editors/compilers. 

Reference Manual The S7 CPUs contain system and standard functions integrated in the operating system. 
System and Standard These can be used while programming your system. This manual provides an overview 
Functions of the function and organization blocks available in S7, together with detailed de scrip-

tions of the interfaces (as reference information) for use in your user program. 

System Overview PCS 7 This description provides an overview of the components and functionality of the 
SIMATIC Process Control System 7 and includes the topics which are of interest 
when operating a control system. 

ESManual The Engineering System (ES) Manual for the Plant Hierarchy (PH) and 
Import/Export Assistant (lEA) from the optional PCS7 Engineering package sets out 
the basic principles and a describes the procedure for configuring a plant, regardless 
of the phase, in relation to the equipment it contains. 

CFCManual The manual for the CFC configuration tool (in the optional PCS 7 Engineering package) 
provides an overview and describes how to create an entire software structure from pre-
defined blocks. 

While you are using the software, you can use the on-line help to answer all your detailed 
questions on use of the CFC editor. 

SFCManual The manual for the optional SFC Control System module provides the information 
you need for planning sequential control systems. 

While you are using the software, you can use the on-line help to answer all your detailed 
questions on use of the SFC. 

Reference manuals for The "Standard Blocks", "Blocks for PROFIBUS" and "Field Device Blocks" 
the block libraries manuals contain detailed information on the blocks available in the libraries. 

BATCH flexible manual This manual describes how to automate batch processes, and includes sections on 
batch scheduling and batch data management. 

Manuals for WinCC The manuals provide information on planning and working with the operator control 
and monitoring system. They all contain descriptions of the hardware, software and 
process control. 
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Preface 

How to use this 
manual 

Conventions 

Further support 

Note 

vi 

This manual is divided into the following topics: 

• Chapter 1 contains general information on the Engineering System, its 
components and views. It covers the device-independent aspects and the 
individual engineering phases. 

• Chapter 2 contains brief description for total beginners. It shows what to 
do - from starting the program for the first time through to configuring an 
entire plant - all with reference to an example (session model). 

• Chapter 3 describes the plant hierarchy. It will answer your questions on 
how a plant is structured, how the HID is formed and how devices and 
objects are assigned, for example. 

• Chapter 4 describes how to import and export configuration data, create 
templates and generate the software using the Import/Export Assistant . 

• Chapter 5 describes PLC and OS-independent configuration. 

• Chapter 6 contains information on how to document your work. 

• The appendix contains a chapter with the Technical Data, a list of 
abbreviations used in the Engineering System and a description of the 
available documentation. 

• At the end of the documentation there is a glossary with the explanation 
of important terms and an index which help you to find texts on important 
points rapidly. 

References to further documentation are made by means of the literature 
numbers between slashes, for example / .. ./. These numbers will allow you to 
take the precise title of the document from the documentation list. 

If you have any further questions on the software which are not answered in 
the paper documentation or in the on-line help, please contact your Siemens 
representative or branch. 

If you have any questions or remarks on this manual, please complete the 
questionnaire at the end of the manual and send it to the address indicated. 
Please let us know what you think about the manual as well. 

We offer courses to help you start working with the SIMATIC S7 PLC. 
Please contact your local training center or the central training center in: 

1. D-90327 NOmberg, Tel.+ 49 911 I 895 3202 Fax: +49 911/895 32 52. 

2. D- 78187 Karlsruhe, Tel. + 49 721 595 2 917, Fax: +49 72 1/595 6087. 

The user section of this manual does not contain precise instructions for the 
individual steps, but rather explains the fundamental procedure. More detailed 
information on the individual dialogs of the software and editing them can be 
found in the respective the on-line help. 
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The Engi neeri ng System 1 

Overview 

In this Chapter 

In the first chapter, we introduce you to the principles of the Engineering 
System (ES), together with its "Plant Hierarchy" (TH) and "Import/Export 
Assistant" (lEA) software components and the interaction between these 
components within the ES. 

You will learn the difference between a plant-oriented and a device-oriented 
view, what are the device-independent aspects and the appearance of the 
individual engineering phases. 

This chapter deals with the following topics: 

Section Topic Page 

1 .1  Components of the ES 1-2 

1 .2 Component view and plant view 1-4 

1 .3 Device-independent aspects 1-7 

1.4 Phase-independent aspects 1-8 

1.5 Engineering procedure 1-10 
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The Engineering System 

1 .1 Components of the ES 

ES software in 
SIMA TIC PCS 7 

1-2 

The components of the engineering system (ES) in the SIMATIC Process 
Control System 7 (PCS 7) are tools which enable you to configure your 
system comprehensively and in a device-independent manner. These ES 
components are the following software packages: 

• STEP 7 basic software 
This contains the SIMATIC Manager which forms the superstructure for 
all the ES components and manages these components centrally. It is a 
graphical user interface running under Windows 95. 
Hardware is configured, i.e. racks, modules and interface modules are 
arranged in the SIMATIC Manager dialog via a configuration table 
(HWKonfig). 

• Plant Hierarchy (TH) and Import/Export Assistant (lEA) 
Both "PH" and "lEA" are optional control system packages. They 
supplement the SIMATIC Manager and, therefore, are not separate 
applications. The functions are called up via menu commands. 

PH and lEA support the phase-independent and plant-wide configuration 
of process and production plants. This type of engineering is based on 
aspects relating to the equipment in the plant. 

• Sequential Function Chart (SFC) 
This is a software package that can be configured using sequential control 
systems. A sequential control system is used to control and selectively run 
basic automation functions (which are usuall created using CFCs) by 
means of operation and status changes. 

The SFC software package, together with "PH" and "lEA", is part of the 
optional control system package. 

• Continuous Function Chart (CFC) 
This is a software package for configuring the flow of data for basic 
automation functions. The CFC is used to create an overall software 
structure from prepared blocks, i.e. to graphically interconnect the 
functions of individual items of equipment. 

The blocks are classified by functionality and are contained in libraries. 
You can drag & drop the blocks you want from these libraries (which can 
be displayed as a tree view) and insert them into the CFC. 

• Structured Control Language (SCL) 
This is a programming language for programming complex tasks in a 
PLC. In the ES, it is used to create block types, for example. 

• WinCC configuration software 
This is used to configure the operator interface system (Windows Control 
Center) in PCS7. 

Manual Engineering System (ES) 
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Plant-wide 
engineering 

The Engineering System 

Plant-wide engineering has the following benefits: 

• It enables objects of significance to the plant (units, PICS units, etc) to be 
handled independently of the component view. 

• It enables objects to be arranged in a plant hierarchy, thus structuring the 
system according to functions or equipment (see Figure 1-2). 

• Objects are given a unique name, throughout the project, by allocating a 
higher level designation (HID). 

• Data can be taken from previous planning and configuration phases and 
reused (phase-independent engineering). 

• Data can be returned to the previous planning and configuration tools in 
order to compare the system documentation. 
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The Engineering System 

1 .2 Component view and plant view 

Various views 
in the ES 

Objects of the ES 

1 -4 

The objects of the control system can be represented in different views for 
various tasks. For example, a commissioning engineer will want to know 
which functions are running on the CPU, and the technicians will need to 
know which units belong to a system. 

The ES contains the component view (standard hierarchy) and the plant 
view (plant hierarchy) for configuring a process control system. In the 
component view, you can toggle between the off-line and on-line views. To 
switch between views, select one of the following menu commands from the 
View menu in SIMATIC Manager: 

• Standard hierarchy 

• Plant hierarchy 

• Off-line 

• On-line 

Another view is the local view, which shows the three-dimensional structure 
of the plant. This local view is implemented with other tools and is not a part 
of the ES. 

One important feature of these views is that the objects displayed in them 
exist only once, but will appear and can be handled in different views. 

In plant hierarchy or standard hierarchy window, the objects in the left-hand 
pane are displayed in a hierarchical tree structure. In the right-hand pane, the 
objects are displayed in the form of an open container. The containers of the 
individual hierarchical levels may contain "leaf objects". A leaf object, such 
as a CFC chart, cannot be opened further within the hierarchy and 
consequently will only appear in the right-hand pane. Double-click on the 
icon representing the leaf object to start its application. 

Manual Engineering System (ES) 
C79000-G7076-C711 -02 www . 

El
ec

tric
alP

ar
tM

an
ua

ls 
. c

om
 

www . 
El

ec
tric

alP
ar

tM
an

ua
ls 

. c
om

 



Standard hierarchy 

Plant hierarchy 

The Engineering System 

The standard hierarchy (component view or device-oriented view) is used to 
configure the hardware for your project (control system hardware, such as 
PLC and OS). The objects concerned are designated as components 
according to their significance (e.g. chart container, OS, PLC, station, etc). 

El- ..@ project1 

8-. SIMA TIC 400 station1 

�-1£1 CPU 416-1 

Figure 1-1 

� CWJ S7 program1 

:-- -[i] Sources 
I 
1- {OJ Blocks 
I L-8 Charts 

Standard hierarchy 

� CFC1 

The plant hierarchy (plant or functional view) is used to structure a project on 
the basis of the equipment used, i.e. you classify the automation, operating 
and monitoring functions in a hierarchical format. This classification 
increases the clarity and enables you to handle the plant objects (systems, 
units, PICS units, etc) as a single unit. In the plant view, you can handle 
objects independently of the devices to which they are actually allocated. 
The objects concerned, i.e. the hierarchical containers, are designated 
according to their importance within the plant. 

Please note that chart names must be unique within the CPU. 

B- @ project1 

e -c;:J V1 oo (system) 

Figure 1-2 

� D RA1 (unit) 

� D T11  (PICS unit) 
L D T1 2 

� 0 T13 

� -QRA2 
:- � P26 
L 0 P27 

Plant hierarchy 

� TIC4711 (CFC chart) 

� TIC4711 (WinCe image) 
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The Engineering System 

HID 

Working with both 
views 
simultaneously 

Recommended 
procedure 

1-6 

The hierarchical container of the plant hierarchy can be used to create the 
naming convention on the basis of functional aspects. This hierarchical path 
forms the higher level designation (HID). This is used, via a dialog, to 
specify which levels (containers) are to be used for naming. 
Example (from Figure 1-2) for an HID: V100\RA2\P26 

The component view and plant view can be displayed simultaneously in the 
project viewer window: (select from the Options menu-+ Customize .. . --+ 

"Always generate window when switching between views"). Objects such as 
CFC charts, etc, can be transferred (allocated) from the component view 
(off-line) to the plant view using Drag&Drop. 

You can also change the view in the active window without having to open a 
new window. In the SIMJXfiC Manager "Options" menu, simply deselect 
"Always generate window when switching between views" in the 
"Customize" dialog box. 

We recommend the following method: 

• First configure the hardware (PLC and OS) in the component view. 

• Then create the structure of the system in the plant view and allocate the 
hierarchy containers to the hardware. 

• You can now place and edit all the charts and images in the plant view. 

Since they have already been assigned to the hardware, the charts and 
screen are stored in the chart containers and OS stations concerned. 

• You can now add further hardware at any time. 
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The Engineering System 

1 .3 Device-independent aspects 

Device­
independent 
relationships 

Functions 

Restrictions 

When you create an automation task, there are almost always 
device-independent relationships between the individual structures, e.g. 
automation sequences in the PLC must be run and monitored on an OS or 
several PLCs of a device have to communicate with one another. 

The plant objects used in the plant view (systems, units, PICS units, etc) in 
turn contain other objects (leaf objects, such as CFC/SFC charts with blocks, 
OS screens, etc), which are normally distributed between several devices 
(PLC, OS, field devices) that make up the control system. 

When you use the plant objects (New, Copy, Rename, Move, Delete), the 
functions generally affect several devices. With plant-wide engineering, the 
device-independent relationships within the engineering system (ES) are 
managed, thus guaranteeing consistency and functional capability of the 
automation structures. 

The functions that can be executed during plant-wide engineering and their 
device-independent relationships are managed by the ES and include, for 
example: 

• Copying an entire unit containing charts for the PLC and screens 
for the OS. 

• Deleting a unit, thus deleting all objects belonging to that unit. 

• Moving a unit to other devices (PLC and OS). 

In the current version of the PCS 7 optional package "TH/IEA", the 
PLC-PLC and PLC-OS links and data are not automatically corrected. Please 
note the following restrictions: 

In the case of PLC-PLC links, you must map these links onto CFBs 
and link the CFBs in turn via a communication channel. 

- In the case of PLC-OS functions, the display blocks are copied or 
moved together with the image, although they still refer to the 
previous WinCC DM variables. These must be corrected in WinCC. 
When you move or copy to another OS, you are supported by the 
function which list graphics objects that are no longer connected. 
When you copy within an OS, the ES does not provide this support. 
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The Engineering System 

1 .4 Phase-independent aspects 

General 

Engineering 
phases 

1 -8 

The engineering of a process control system is just one part of the overall 
configuration of a process or production plant. Data that has already been 
recorded or created using other tools may be reused during engineering. This 
assumes that the phase-independent work has already been carried out. 

The engineering for a plant comprises the following phases (as specified in 
Namur worksheet NA 35: "Implementation of EMR!PICS projects"): 

• Determination of the basic principles 
This stage involves determining the aims of the project, rough castings, 
etc. 

• Preliminary planning 
This phase is used to specify the plant concept and calculate the costs. 

• Basic planning 
In this phase, the PICS functions and the process-related data are 
specified, technical implementation clarified and the resulting costs 
calculated. 

• Implementation planning 
This phase is used to plan which devices and central equipment will be 
used. The control system is specified, the unit charts, the unit function 
charts and the assembly documents are drawn up. 

• Set-up 
In this phase, equipment is ordered, deliveries confirmed, the software for 
the control system is configured, the plant is assembled and its functions 
are tested. 

• Commissioning 
In this phase, the personnel are trained and the commissioning takes 
place. The documentation is drawn up for the entire plant. 

• Project completion 
In the final phase, the completion report is drawn up and the final costs of 
the project are billed. 
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Preliminary 
planning 

Specification 
Regulations 
Standards 
Laws 

Plant engineering 

Basic planning 

Basic flow chart 
Process flow chart 
Implementation 
flow chart 

The Engineering System 

Detailed planning 

PICS unit charts 
PICS unit function charts 
PICS unit description 
Field and signaling level 
Cabinet planning 

Control system engineering 

Type library 

PLC objects 
OS objects 

CS project 

Plant hierarchy 
PLC functions 
O&M functions 
Recipes (batch) 
CS hardware 

Control system (runtime) 
PLC functions 
Field devices 
O&M functions 
Prod. recipes (batch) 

Specimen 
solutions 

PICS units 
devices 

Figure 1-3 Interaction between plant and control system engineering 
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The Engineering System 

1 .5 Engineering procedure 

Plant planning 

CS engineering 

1-10 

The plant planning procedure is as follows: 

• Use of the library with functional units (application standards) 

- Binary input with message 

Measured value acquisition with messaging function 

Fixed setpoint control with measured value acquisition 

Cascaded control 

- Ratio control 

- Split range control 

Setpoint generator I output value generator 

Metering 

Motor control unit 

- Motor control unit with two speeds 

Motor control unit with two directions of rotation 

Motor control unit for variable-speed drives 

Open/close valve 

Three-way valve 

The plant functions are carried out by functional units, each of which has 
its own data sheet (PICS unit description). 

• The functional units are allocate specific values. 

The procedure for CS engineering with the lEA is as follows: 

• Use the library of specimen solutions for automation, operating and 
monitoring, adapting them to suit the functional units. 

When automation solutions are created for medium-sized and large-scale 
projects, partial solutions that have already been implemented (called 
specimen solutions below) can often be reused. The engineering system 
supports the reuse and adaptation of specimen solutions. This will enable 
you to edit CFC charts and process signals via the dialogs and in list 
form. You can specify or edit the parameters and signals without having 
to open the CFC charts or symbol tables concerned. 

• Allocate specific values to the links between blocks. 

You can import datasets, allocate their structure to the specimen solution 
and automatically copy and configure specimen solutions. 

The procedure used in the past had the disadvantage that the same data 
had to be entered several times. 

For working with the lEA, see chapt. 4. 
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Getting Started 2 

Overview 

In this Chapter 

This "Getting Started" chapter is intended for users who are not yet familiar 
with the ES and want a brief overview of the system. An example will be 
used to show how, after starting the SIMATIC Manager, a project is created, 
how a plant is structured in the plant hierarchy and how specimen solutions 
can be used with the lEA. 

This chapter deals with the following topics: 

Section Topic Page 

2.1 Creating a project 2-2 

2.2 Structuring a plant in the plant hierarchy 2-4 

2.3 Working with the Import/Export Assistant 2-7 
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Getting Started 

2.1 Creating a project 

SIMATIC Manager 
Standard hierarchy 

2-2 

Mter starting SIMATIC Manager, create the project in the "Standard 
hierarchy" view: 

File ..,. New ..,. Project. •• 

This will open the dialog box containing all the existing projects. Enter the 
name of the project ("proj97" in this example) and click on "OK" to confirm. 

The project viewer window will appear on screen. This is divided into two 
fields: The left-hand field contains the container with the name "proj97" and 
the right-hand field contains the symbol for the MPI network. 

First enter the hardware in the following order: 

Insert ..,. Station ..,. SIMATIC 400 station 

Edit ..,. Open Object 

This will start HWCONFIG and open the hardware catalog. Select the rack: 

SIMATIC 400 .... RACK 400 .... URl 

The window "URl" with the table of slots will appear in HWCONFIG. Now 
Drag&Drop from the hardware catalog to insert the power supply and CPU: 

PS 400 .... PS407 lOA 

CPU 400 .... CPU416-1 

The PS407 occupies slots 1 and 2 and the CPU is in slot 3 .  Now exit 
HWCONFIG with 

Station ..,. Save 

Station ..,. Exit 

The SIMATIC Manager project viewer window now contains the icon for the 
station and, below that, the icon for the CPU and the icon for the S7 program. 

Browse through the project viewer window until you find the container for 
the S7 program and double-click on it. This will open the S7 program with 
the containers for the source code "Sources", for the "Blocks" user program 
and the symbol list "SY". 

Now insert the "Charts" container: 

Insert..,. S7 software ..,. Chart container 
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d:J- � SIMATIC 400 station(1) 

B- i1 CPU 416-1(1) 

� -� S7 program(1) 

dJ-� Blocks 
I 4J- -{i] Sources 

dJ- --[QJ Charts 

Getting Started 

[OJ Blocks [OJ Charts 

This will place the project in the standard hierarchy. The next control system 
engineering steps are carried out from the plant view. 
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Getting Started 

2.2 Structuring a plant in the plant hierarchy 

Switching between 
views 

Plant hierarchy 

Defaults 

2-4 

Now switch from the "Standard Hierarchy" view to the "Plant Hierarchy" 
view. 

View ..,. Plant Hierarchy 

The switch for "Always generate window when switching between views" is 
set in the SIMATIC Manager settings. To set this switch, use the 
"Customize ... " function from the "Options" menu). When you now switch to 
the plant hierarchy, another window will be opened. 

The plant hierarchy window contains the icon for an open container. This 
container represents the project. You can specify further hierarchical levels 
and thus the plant structure from here. 

Insert ..,. S7 Program ..,. Hierarchy Container 

This inserts a hierarchy container representing the hierarchical level of the 
plant. The name will be highlighted and the cursor activated. You can now 
change the name if you wish (in this case: to "VlOO"). 

You can now define the plant hierarchy, i.e. set the defaults for the rest of the 
plant structure. To do this, select: 

Options..,. Defme Plant Hierarchy 

The dialog box with the same name is divided into three areas: 
In the "Identifier'' area, enter the maximum number of hierarchical levels (in 
this example "4") . 

The separator "\" remains unchanged. This is used to separate the container 
names are listed one after another in the HID. 

As the documentation prefix, enter the name of the factory and the area, in 
this case "22/DRAL". This prefix does not appear in the HID since it is only 
of relevance to the documentation. 

In the area "Settings for each level", specify the following for each 
hierarchical level: 

- the maximum number of characters for the container name in the HID: 
Set under "Max. number of characters" using the UP I DOWN arrows. 

whether the container name should form part of the HID: click on the 
"Identifying" check box. 

- whether there should be a separator after the name: click on the "With 
separator" check box. 
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Structuring 
the plant 

Allocation 
to the PLC 

Getting Started 

The "Preview", displays the HID (with the prefix in brackets) as it was 
specified in the defaults, i.e. the number of digits corresponds to the 
maximum number of characters and the number designates the hierarchical 
level. 
Example: 
111111\22222222\3333333333 
The name of the first hierarchy container may contain up to 6 characters, the 
second name up to 8 characters and the third name up to 10 characters. 

Once you have updated the defaults and closed the "Define Plant Hierarchy" 
dialog box by clicking on "OK", you can now continue to structure the plant. 

Let us insert two further levels: for the unit and for the PICS unit. Change the 
names to "RAl" for the unit and "TOl" for the first PICS unit. 

Call up the Properties dialog for the selected container "RAl". Right-click 
with the mouse pointer on the container in order to call up the context menu. 
Then click on "Object Properties" and, in the dialog box, on the "Allocate to 
PLC and OS" index. 

To complete the "Allocated PLC" field, click on the "Browse ... " button. In 
the "Open" dialog box and the project structure 

• browse until you find the S7 container, and select it, 

• then select the chart container from the right-hand window, 

• click on "OK'' to confirm. 

Please note: If you browse through the project structure until you find the 
chart container and select it, it will not have an object name and an error 
message will appear. 

Click on "OK" to return to the "Properties" dialog box; you will see that the 
path "S7 program(l )\charts" has been entered. 

• Click on the "Pass selected allocation to lower-level hierarchy container" 
check box. 

• Click on "OK" to close the dialog box. 
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Getting Started 

Inserting CFC 
charts 

2-6 

Select the container "TOl" and insert a CFC chart: 

Insert ..,. S7 program ..,. CFC 

Change the chart name to TICA+ 

5.l SIMA TIC Manager- proj97 l!!li1 E3 
EUe J;.dit Insert fLC 'J/jf!IN .Qptions Wtndow J:lelp 

J: proj97 • <Standardhierarchie> (Project) 1!!1:1 13 

EJ- J; proj97- <Technologische Hierarchie> (Project) 1!!1:113 

EJ-ru proj97 
�-Dv100 

I 
El-QRA1 

�-�T01 

�TICA+ 

If a sequential control system is required in the project, insert an SFC chart as 
well. 

Insert ..,. S7 program ..,. SFC 

Note 

Configuration of CFCs and SFCs is described in the Getting Started chapter 
of the relevant documentation, so it will not be described in further detail 
here. See /254/ and /255/. 
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Getting Started 

2.3 Working with the Import/Export Assistant 

Task You want to prepare so-called specimen solutions for functional units (e.g. a 
cascaded control from the plant planning) which can subsequently be copied 
and modified to suit the specific solution whenever necessary. 

What used 
to happen .... 

Importing 

The charts were created with the CFC editor. The necessary blocks were 
incorporated and interconnected in these charts, and the parameter and signal 
1/0 points to be used for the specimen solution were determined. 

You already have an import file containing the import data (parameters I 
signals) which can be assigned to the specimen solution. 

You must create a separate import file for each different type of functional 
unit or type of specimen solution. 

Select the container "RA1" and then: 

Options .... Import/Export Assistant .... Import. •• 

Once the block 1/0s have been read in, the "Import" dialog box with the first 
sub-dialog is opened: 
"Specimen solution: Select parameters and signals". 

The parameters and signals have already been selected for the lEA in the 
CFC editor, so you can switch to the next sub-dialog using the "More>" 
button: 
"Allocate import data structure to specimen solution" (see 4.2.2) 

Enter the name of the import file in the "Import file" field. To do this, click 
on the "Browse" button and look for the file you want in the pop-up dialog 
box. 

Once the file has been read in, the column headers for the parameter and 
signal I/O points appear in the left-hand field. 

Now allocate all the column headers to the parameter and signal l/0 points 
(using Drag&Drop or by selecting the source and destination and clicking on 
the ">") button. 
This is a 1 :1  allocation, i.e. there must be the same number of lines in each 
window and, at the end, all the column headers must have been allocated. 

Click on "More" to move on to the next sub-dialog: 
"Carry out import process" (see 4.2.3) 

Each line in the import file represents one HID. The lEA will now create the 
hierarchy container as specified in the import file, i.e. the project structure 
will be supplemented with the number of HIDs (if they are not already 
present). 
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Getting Started 

Testing and 
commissioning 

Export 

Compare system 
documentation 

2-8 

The specimen solution "RAl" is copied to the hierarchy container (as per the 
HID). The parameter and signal descriptions on each line are written to the 
parameter and signal I/O points for the copied specimen solution. Each line 
therefore corresponds to exactly one specimen solution. 

You can now use your specimen solutions for testing and commissioning (see 
/254/). To do this, compile the chart container and load the program into the 
CPU. 

You can now check the program and modify any parameters, if necessary. 

After modification, the documentation should be compared with the plant 
planning. To do this, you must first export the current data for the project. 

To export (see 4.3), select the container "RAl" (or another container by 
importing a copied specimen solution and click on: 

Options .... Import/Export Assistant .... Export. .. 

In the Export dialog you can rename the export file if you do not want to 
overwrite the import file. 

The data in all specimen solutions of this type will now be written line by 
line to the export file. 

The export file can now be used to compare the system documentation with 
another planning tool. 
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Plant h ierarchy 3 

Overview This chapter describes how to use the ES "Plant hierarchy" function package 
and the way in which it works. 

In this Chapter This chapter deals with the following topics: 

Section 

3.1 

3.1.1 

3.2 

3.2.1 

3.2.2 

3.2.3 

3.3 

3.3.1 

3.3.2 

3.4 
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Topic 

Introduction 

User interface 

Structuring a plant 

Creating the plant hierarchy 

Inserting objects into hierarchy containers 

Detailed view of leaf objects 

Settings and properties of the PH 

Defining the plant hierarchy 

Properties for hierarchy containers 

CFC and SFC charts in the PH 

Page 

3-2 

3-2 

3-3 

3-3 

3-3 

3-4 

3-5 

3-5 

3-7 

3-10 
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Plant hierarchy 

3.1 Introduction 

Plant objects The plant hierarchy can be used to break a project down on the basis of the 
equipment it contains. Plant objects are systems, units, PICS units, etc which 
are created as hierarchy containers within a tree structure (may also be 
nested). The leaf objects are also regarded as plant objects. 

CFC and SFC charts 

OS objects, such as images and reports 

Standard documents (from WORD, EXCEL, etc.) 

3.1 .1 User interface 

SIMATIC Manager 

View 

3-2 

The "Plant hierarchy" is mapped on the SIMATIC Manager user interface. 
The general SIMATIC Manager functions are described in /231/. 

The menu have been extended with functions specific to the "Plant 
hierarchy". These are, in the "View" menu, the functions for switching 
between the views 

• Standard hierarchy (see Figure 1-1) 

• Plant hierarchy (see Figure 1-2) 

and, in the "Options" menu, the function 

• Plant hierarchy 

Define 

Check naming convention 

Display log 

(see section 3.3.1) 

The "Plant hierarchy" or "Standard hierarchy" function in the "View menu is 
used to either to switch the view in the current window of the called project 
or to generate another window with the selected view, depending on the 
defaults. 

To set this default in the "SIMiXI'IC Manager", select the "Customize ... " 
function from the "Options" menu and then either select or deselect the 
"Always generate window when switching views" check box. 
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Plant hierarchy 

3.2 Configuring a plant 

Requirement You must first have created a project in SIMATIC Manager and created an S7 
program, together with a chart container in the "off-line" view of the 
standard hierarchy. This will ensure that you have the resources required to 
insert CFC charts, for example, into the plant hierarchy. 

There must also be an OS in order to incorporate OS screens and reports. 

3.2.1 Creating the plant hierarchy 

Call PH From the "View" menu, select the "Plant hierarchy". The PH window will 
contain the project container for the hierarchical levels of the project to be 
configured. 

Insert hierarchy 
container 

Editing equipment 
names 

Copy I delete 
hierarchy 
container 

When you insert the first and subsequent hierarchy containers, even if they 
are nested, you create the structure and thus the subdivision of the plant. 

To create new hierarchy containers, select the "Hierarchy container" function 
from the "Insert" menu or "Insert new object" from the context menu. 

Once you have inserted a hierarchy container, it will be displayed on the 
right-hand side of the window. You can now change the name if you wish: 
The name field with the name assigned by the system is highlighted and the 
cursor is position after the last characters of the container name. You can now 
enter the desired name using the keyboard (Delete and Edit). 

If you copy or delete hierarchy containers, all the objects contained in them 
will be copied or deleted as well. This will enable you, for example, to copy 
a complete unit in a single step. You then simply have to make the 
modifications to the copied unit (e.g. by linking it to the process signals). 

3.2.2 Insert objects into hierarchy containers 

Leaf objects Leaf objects, such as CFC and SFC charts, OS leaf objects (images, reports) 
and additional documents (Standard WORD, EXCEL documents, etc.) can be 
inserted into hierarchy containers. 
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Plant hierarchy 

Names 

Move 

Connections 
between the views 

Tip: 

Leaf objects that were created in the standard hierarchy can be assigned to 
the desired hierarchy container (using Drag&Drop). If they have already been 
assigned to a hierarchy container, the objects will be copied. 

When you create a new leaf object, it will automatically be assigned a name 
+ number (e.g. CFC chart: CFC3). The name space is that specified in the 
standard hierarchy. When you insert an object from the standard hierarchy, it 
will be given its old name (assigned by the system or user) (e.g. SFC-LaLi). 

When you move leaf objects to a hierarchy container with another resource 
assignment, the previous assignment of the leaf object will be changed as 
well. 

If you move entire hierarchy containers, this will not affect the resource 
assignment of the leaf objects in the container. 

Since the views of the standard hierarchy and the plant hierarchy show 
various aspects of the same leaf objects, certain functions on these leaf 
objects will also take effect in both views. 

• If you delete objects, they will be deleted from both views 

• If you create New objects in the plant hierarchy, they will also be 
created in the PLC I OS assigned to the hierarchy container. 

• If you create New objects in the standard hierarchy, this will have no 
effect on the plant hierarchy. 

If the plant hierarchy has been created, you should only edit objects in this 
view. The standard hierarchy will then only be used to edit the PLC and OS. 

3.2.3 Detai led view of the leaf objects 

Path name 

3-4 

In the detailed view (which can be set using the Toolbar or the "View" menu 
in SIMATIC Manager) the hierarchy paths of the leaf objects are shown in 
the right-hand window below the "symbolic name" column header, thus 
identifying the assignment to any other hierarchies (in the PH, this is the path 
of the standard hierarchy and in the standard hierarchy it is the path of the 

plant hierarchy). 
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Plant hierarchy 

3.3 Settings and properties of the PH 

3.3.1 Define plant hierarchy 

The HID 

Define PH 

The naming convention for the plant hierarchy is defined for each project. 
The names of leaf object do not form part of the name, i.e the higher level 
designation (HID) is formed only from the names of the hierarchy containers. 

Once you have created the first hierarchy container, you can then define the 
plant hierarchy. This means that you set the defaults for subsequently created 
hierarchy containers and for the designation and settings for the individual 
levels. 

Once you have selected or opened an hierarchy container, call up the "Define 
plant hierarchy" function from the "Options" menu (or from the context 
menu via the "Options" function). A dialog box with the same name will 
appear on screen (Figure 3-1 ). 

Figure 3-1 "Define plant hierarchy" dialog box 
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Plant hierarchy 

Higher level 
designation 

Settings per level 

Checking the 
naming 
convention 

3-6 

The following options are used to determine the display of the PH: 

Number of hierarchical levels 
You can configure up to 5 hierarchical levels. Use the "UP I DOWN" buttons 
in the input field to set the maximum number in your project. 

Documentation prefiX 
Here you can enter up to 32 characters. This prefix does not appear in the 
HID since it is only of relevance to the documentation. It can be printed out 
in the footers of the objects (CFC/SFC charts, images/reports). The 
documentation prefix can be used, for example, to preset the works 
designation and the area (22 I DRAL) for the project. 
The "Preview" box shows the prefix in brackets (see Figure 3-1). 

This part used to specify, for the individual hierarchical levels, whether they 
are to contribute to the identifier formation, the maximum number of 
characters that can be entered and whether they should be followed by a 
separator. 

Use the "UP I DOWN" buttons in the input field to set the maximum number 
of characters in your project. The "Preview" area will display the setting in 
the form of the appropriate number of of digits (with the separator, if set). 

The names of identifying hierarchy containers are included in the HID. You 
can use non-identifying containers to create other "pigeonholes" (e.g. for 
additional documents such as: plant descriptions, measuring point data 
sheets, etc). You can also specify or change whether the name is to form part 
of the HID or not at a later date for a specific object using the "Object 
properties" (see section 3.3.2). 

When doing this, you should endure that the name of the hierarchy container 
must be unique within an identifying hierarchy container. 

You can use the 
"Options .... Plant hierarchy .... Check naming convention" to specify 
whether the settings have been followed within the project. The settings may 
be violated, for example, if you subsequently modify settings or move 
containers to other levels. 
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Plant hierarchy 

3.3.2 Properties for hierarchy containers 

Call dialog 

"General" 

You can assign certain properties to the hierarchy containers. To do this, call 
the Properties dialog for the selected container. Select the "Object 
Properties" function from the "Edit" menu or Context menu to call up the 
dialog box containing the following indexs: 

• General 

• Assignment to PLC and OS 

The "General" index is used to set or view the general properties of the 
hierarchy container: 

• Name: 

Here you can change the name of the hierarchy container. You stipulated 
the maximum number of characters in the "Define plant hierarchy" dialog 
(see Figure 3-1). 

• "Name is is part of the higher level designation" check box: 

The "Define plant hierarchy" can be used to change existing defaults, i.e. 
you determine whether the selected hierarchy container should contribute 
to the name of the HID. 

• OS area identification: 

Here you can enter an OS area identification if none of the containers in 
the higher hierarchical levels has an OS area identification. The OS area 
identification is passed on to (inherited by) all lower level hierarchy 
containers, OS images, OS reports and messages. 

The OS area identification is used in WinCC to ensure that various 
operators are offered only those images, reports and messages that belong 
to their particular areas. 

• Higher level designation (HID): 

Here you can see the HID of the hierarchy container, i.e. the path of the 
hierarchy container from the topmost level down to the selected hierarchy 
container (for identifying containers). 

• Author: 

Here you can enter the name of the author (programmer) of the hierarchy 
container. 

• Created on: 
Last modified on: 

Here you can see the date on which the hierarchy container was created 
and the date on which it was last modified. 

• Comment: 

Here you can enter a comment (up to characters) 

Manual Engineering System (ES) 
C79000-G7076-C711 -02 3-7 www . 

El
ec

tric
alP

ar
tM

an
ua

ls 
. c

om
 

www . 
El

ec
tric

alP
ar

tM
an

ua
ls 

. c
om

 



Plant hierarchy 

"Assignment to 
PLC and OS" 

3-8 

In the "Assignment to PLC and OS" you can assign a PLC and an OS to the 
hierarchy container. In this way you will set which PLC resource (chart 
container) contains the CFC/ SFC charts and which OS resource (WinCC 
station) contains the images and reports contained in this hierarchy container 
or which have been inserted into this container. 

Note 

You cannot insert CFC/ SFC charts or images I reports into the hierarchy 
container unless the PLC or OS has already been assigned. 

• Assigned PLC: 

Here you can see the path of the "Charts" container from the standard 
hierarchy view or the text "Not assigned". 

To assign a PLC resource, click on the "Browse ... " button to open a 
dialog box and select the desired chart container from the current project. 

The assignment will be immediately adopted by all objects inserted into 
the hierarchy container (CFC/ SFC charts, hierarchy containers). 
You can Undo the assignment by selecting "Not assigned" from the 
combination field. 

• Lower-level hierarchy containers 

If you click on the "Pass selected assignment to lower-level hierarchy 
containers", all the lower-level hierarchy container will inherit the 
assignment set at the current hierarchy container. 

Above the check box, you will see a text which indicates the type of 
assignment: 

"All lower-level hierarchy containers have the selected assignment": 
From the selected hierarchy container downwards, all the hierarchy 
container will be assigned the same PLC. 

- "There are hierarchy containers with a different or no assignment": 
Below the lower-level hierarchy containers, there are some which do 
not have the same assignment as the selected hierarchy container. 

"There are no lower-level hierarchy containers": 
The selected hierarchy container is at the topmost level of the 
hierarchy. 
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Plant hierarchy 

• Assigned OS: 

Here you can see the OS currently assigned to the hierarchy container or 
the text "Not assigned". 

Click on the "Browse" button to open a dialog box in which you can 
select an OS from all those available in the current project. 

The assignment will be immediately adopted by all objects inserted into 
the hierarchy container (images I reports, hierarchy containers). 
You can Undo the assignment by selecting "Not assigned" from the 
combination field. 

• Lower-level hierarchy containers 

The conditions for the OS assignment are the same as those for the PLC 
assignment (see above). 

Note 

The PLC or OS assignment will only be passed on to the lower-level 
hierarchy containers. The assignment of existing CFC/ SFC charts or 
images/reports will not be changed. 
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Plant hierarchy 

3.4 CFC and SFC charts in the PH 

Title row of the 
CFC and SFC 

Marginal 
entry in the CFC 

SFC zoom 
configuration 

3-10 

In the PH, you can open and edit leaf objects such as CFC and SFC charts by 
double-clicking. The title row shows the hierarchy path of the PH. This will 
also be displayed if the chart is opened in the standard hierarchy, i.e. if the 
chart has been assigned to a hierarchy container, this will determine the path 
name. 

The hierarchy path (HID) of the PH is displayed in the margin of the CFC 
chart, before the chart name and block name. 

In the SFC, the operands of actions and conditions that represent the 
parameters of objects (e.g. chart name.block name.block 1/0) which have 
been allocated to the PH are also displayed with this hierarchy path. 

This also applied to charts that were created and edited in the standard 
hierarchy and have subsequently been assigned to the PH. 
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Import-Export-Assistant 4 

Overview This chapter describes the structure of the user interface and basic principles 
for using the Import/Export Assistant. 

In this Chapter 

Requirements 

This chapter deals with the following topics: 

Section Topic 

4.1 General information on working with the lEA 

4.1.1 Import I export combinations 

4.1.2 The lEA user interface 

4.2 Import 

4.2.1 Configuring specimen solutions 

4.2.2 Assigning the import data structure to the 
specimen solution 

4.2.3 Carrying out the import process 

4.3 Export 

4.3.1 Select specimen solution 

4.3.2 Structure and creation of the export file 

4.3.3 Exporting data 

4.4 Edit 

4.4.1 Selecting parameters and signals 

4.4.2 Entering the parameter description 

4.4.3 Entering the signal description 

4.4.4 Saving your changes 

You need a basic knowledge of Windows 95 in order to understand this 
chapter. 
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Import-Export-Assistant 

4.1 General information on working with the lEA 

Specimen 
solutions 

Figure 4-1 

4-2 

In order to configure specimen solutions, you must first prepare the 1/0s 
between the CFC blocks. This includes identifying the 1/0s between blocks 
that are intended to supply parameter values or signals. This is done using the 
"Parameter 1/0 point" (lEA para) and "Signal 1/0 point" (lEA signal) 
attributes. 

• Parameter 1/0 point 

- all non-interconnected block inputs that can be assigned parameters in 
the CFC but cannot be interconnected 

- all block outputs that can also be assigned parameters in the CFC 

• Signal 1/0 point 

- all block inputs that can also be interconnected in the CFC, but cannot 
be interconnected with other block 1/0s 

- all block outputs that can also be interconnected in the CFC 

Exchange of data between the planning system and the engineering system 

Planning system 

Functional units, 
1/0 signals, 

descriptions, 
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Functions 
of the lEA 

Import-Export-Assistant 

The Import/Export Assistant (lEA) enables you to handle specimen solutions 
and their instances (PICS units). The following functions enable you to reuse 
and adapt specimen solutions: 

• Import 
First declare the parameter and signal 1/0 points or modify existing 
declarations. Then select the import file, assign the parameter and signal 
1/0 points for the import data structures and start the import process. 

• Export 
Once you have reproduced specimen solutions by importing or copying 
and have edited the parameter values and signals, you can then export the 
current data in the same format as it was imported. 

• Edit 
This function is used to select from a table and edit the parameters and 
signals for all 1/0s between all blocks of all CFC charts. This will enable 
you to assign other values, units and designations to the parameter 1/0 
points.For the signal 1/0 points, you can enter new signal names, units 
and designations. 

Please note: 
You can also edit the parameter descriptions directly at the block 1/0 in the 
CFC chart ("Object Properties" dialog in the "1/0s" index) and, if the signals 
have been entered in the symbol table, you can also edit the signals in the 
table. 

However, for larger quantities of parameters and signals, we recommend 
using the lEA and the "Edit" dialog. 

The lEA para and lEA signal attributes are used for all three lEA functions 
(Import, Export, Edit). Thus, if you modify these attributes in one of the 
functions, then the modification will also affect the other two functions. 
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Import-Export-Assistant 

4.1 .1 Import I export combinations 

Possible conflicts 

4-4 

You can assign import/export files to the specimen solutions. This assignment 
is associated with the hierarchy container concerned.lf you copy the 
hierarchy container, then the assignments will be copied as well. The 
following combinations may occur with this process: 

El·� proj97 

Key: 

$·--(lfjl V1 00 

� � , . . .  RA1 

¥ 

l �···(iii RA2 

[7 . .  3 

u . .  2 

u . .  3 

! 
! B{� T01

X1 

¥ :: : 
l l J L. .. lt) X2 

¥ 
u . . 2 

I l B··· T02 

¥ 
[7 . . 2 

! j '�·!Ji X1 u . . 5 
� '· · · · ·!iii RA3 �� V 1 0 1  

j · · · ·lt) RA1 ¥ 
�r.: �lliil RA2 

u . . 1 
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u . . 2 

u . .  4 

u . .  4 

[7 . . 5 
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1 �6·1Ji X1 i [�It) X2 

¥ 
u . .4 

L. .. (fi T02 u . . 1 

u . .  1 Reference to a lower-level case description ¥ 
Already assigned to an import/export file 

� Import/export not possible with this combination 

Figure 4-2 combinations 

1. Neither the selected nor other hierarchy containers in the branch of the 
hierarchy are assigned to an import/export file. 
You can assign attributes to the block 1/0s as required (parameter 1/0 
point or signal 1/0 point) and assign the structure of an import/export file 
without conflicts occurring. 

2. The selected hierarchy container has been assigned to an import/export 
file, but no other hierarchy containers in that branch of the hierarchy have 
such assignments. If you change the attributes of the block 1/0s, you must 
revise the previous assignment to the import/export file. No other 
conflicts will occur. 
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Import-Export-Assistant 

3. The selected hierarchy container has not been assigned to an 
import/export file, but at least one lower level hierarchy container has 
been assigned to an import/export file (in this situation, the possibility of 
case 4 is excluded). 
Here, if you modify the attributes of the block I/Os (only possible in 
"Import/Export Assistant: Edit"), you may have to revise the assignment 
to the import/export files in several hierarchy containers. No other 
conflicts will occur. 

4. At least two hierarchy containers in different hierarchical levels of the 
same branch of the hierarchy have been assigned to import/export files. 
In this case, an error message will be displayed, since it is not logical to 
carry out the import or export. You will either have to move the hierarchy 
container to another level or to another branch of the hierarchy or you 
will have to remove the assignment to import/export files. 

5. The selected hierarchy container has not been assigned to an 
import/export file, but a higher-level hierarchy container in that branch 
has been assigned (in this case, the possibility of case 4 is excluded). 
In this case, if you modify the properties of the block, you will also have 
to revise the assignment to the import/export file in the higher level 
hierarchy container. Import I export is not possible with such a hierarchy 
container. 

6. Specimen solutions have been defined in this branch of the selected 
hierarchy container and these specimen solutions contain more than one 
CFC chart per hierarchy container. Since the name of the CFC chart is not 
part of the HID, no more than one CFC chart may be assigned to each 
hierarchy container. If this were not the case, the parameter and signal I/O 
points could not be clearly determined. 

Note 

The properties of the block I/Os can be modified both in the CFC editor and 
using the lEA functions "Edit", "Import" and "Export". Given the possible 
conflicts described above, you must ensure that you do not accidentally 
modify properties of block 1/0s that have already been assigned to an 
import/export file. In this case, the lEA will display a warning message. 
However, the CFC editor does not have all the information required to 
respond to a warning message. 
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Import-Export-Assistant 

4.1 .2 The lEA user interface 

Start lEA The Import/Export Assistant is started from the plant hierarchy view with 
selected hierarchy containers. 

Classification 

D 
D 
D 
D 
D 
D 
D 
D 
� 
D 
D 
D 
D 
D 
D 
D 
D 
D 
D 

From the "Options" menu, select the "Import/Export Assistant" function and, 
from the sub-menu, select one of the following dialogs: 

• 

• 

• 

Import 

Export 

Edit 

In all three dialogs, a dialog box with the same structure and appearance is 
opened. Each dialog is divided into other, different sub-dialogs which are 
carried out in the order specified by the Assistant. You can control the dialog 
using the buttons at the bottom of the dialog box. 

CFC01 OUT1 BOOL BY_BO 
V100_RA1_T1 - CFC01 1Sec-Vers OUT2 BOOL BY_BO 
V100_RA1_T1 - CFC01 1Sec-Vers OUT3 BOOL BY_BO 
V100_RA1_T1 - CFC01 1Sec-Vers OUT4 BOOL BY_BO 
V100_RA1_T1 - CFC01 1 Sec-Vers OUTS BOOL BY_BO 
V100_RA1_T1 - CFC01 1Sec-Vers OUTS BOOL BY_BO 
V100_RA1_T1 - CFC01 1Sec-Vers OUT7 BOOL BY_BO 
V100_RA1_T1 - CFC01 Sequance_Add EN BOOL ADD_R 
V100_RA1_T1 - CFC01 Sequence_ Add ENO BOOL ADD_R 
V100_RA1_T1 - CFC01 Sequence_Conv1 EN BOOL R_l 
V100_RA1_T1 - CFC01 Sequence_Conv1 EN BOOL R_l 
V100_RA1_T1 - CFC01 Sequence_ Mux EN BOOL MUXB_R 
V100_RA1_T1 - CFC01 Sequence_Mux INO REAL MUXB_R 
V100_RA1_T1 - CFC01 Sequence_Mux IN1 REAL MUXB_R 
V100_RA1_T1 - CFC01 Sequence_Mux IN2 REAL MUXB_R 
V100_RA1_T1 - CFC01 Sequence_ Mux I N3 REAL MUXB_R 
V100_RA1_T1 - CFC01 Sequence_Mux IN4 REAL MUXB_R 

Figure 4-3 Dialog box with table for the specimen solution (example) 

4-6 
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Table of block 1/0s 

Significance of 
the columns 

Table properties 

Import-Export-Assistant 

The first dialog box contains a window divided into columns (table) listing 
all the block parameters. The columns can be resized as required by dragging 
the boundaries between the column headers with the mouse. 

lEA para 
lEA signal 
Here you can see whether a block 1/0 is a parameter or a signal I/O point. 
Click on the attribute in order to change it. 

HID 
This column shows the higher level designation. 

Chart 
This contains the name of the CFC chart, whose block 1/0s have been read in 
for the specimen solution. 

Block 
1/0 
Comment 
This column contains the name of the CFC block, the block 1/0 and any 
comment associated with the block 1/0. 

1/0 
This column describes the type of block 1/0: 
IN = input, OUT = output, IN_OUT = inout. 

Type 
This shows the data type of the block 1/0 (e.g. BOOL ). A list of data types is 
given in the Appendix A.l .  

Block type 
This column shows the type of the block from which the block 1/0 originates 
(e.g. BY_BO). 

Click on the right mouse button to call up a context menu within the table. 
The "Table Properties" function calls up a dialog box for modifying the table 
display, e.g. display horizontal I vertical boundaries, change colours, 
highlight current column, etc. The modified settings can be stored as the 
default. 

The block 1/0 selected for the specimen solution is highlighted in colour in 
the table: 
Parameter blue 

Signals green 
The colours are fixed and cannot be changed. 
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Import-Export-Assistant 

Editing in the table 

Go To ... 

More / Back 
in the dialog 

Complete 

In the first dialog box, you can only select or deselect the check boxes in the 
"lEA para" or "lEA signal" column. In the following sub-dialogs, you can 
only modify the entries with a white background. Text with a grey 
background cannot be modified in this dialog. 
In fields in which only certain input is permitted, a combination box will be 
overlaid when you select (see Figure 4-5), e.g. only "0" or "1" can be entered 
for parameters of data type "Bool". 

Double-click on a row of block 1/0s to open the associated chart after 
confirming the prompt. 
Start CFC and open chart for currently selected parameters? by clicking 
on "OK". 

Click on the "More" or "Back " button to accept the settings and move to the 
next or previous sub-dialog. 

After you click on the "Complete" button, a dialog box containing a log of 
the procedure appears in the last sub-dialog (in this case, in Figure 4-4: 
"Export"). 

C:\SIEMENS\STEP7\Example\exproj01.1EA 
C:\SIEMENS\STEP7\Example\exproj01 .1EA 
C:\SIEMENS\STEP7\Example\exproj01 .1EA 
C:\SIEMENS\STEP7\Example\exproj01.1EA 
C:\SIEMENS\STEP7\Example\exproj01 .1EA 
C:\SIEMENS\STEP7\Example\exproj01 .1EA 
C:\SIEMENS\STEP7\Example\exproj01 .1EA 

V100\RA1\T01\X2\TICA: Signal '1 IN ' exported 0110 
V1 00\RA1\T01\X2\TICA: Parameter '2 1N2 ' exported (10011l 
V100\RA1\T01\X2\TICA: Parameter '3 1N2 ' exported (20ID 
V1 00\RA1\T01\X2\TICA: Parameter 'Controller TN ' exported (20sll) 
V100\RA1\T01\X2\TICA: Parameter 'Controller TV '  exported (1 0siiJ 
V1 00\RA1\T01\X2\TICA: Signal 'Controller l.MN_PER ' exported 0111) 
The file 'C:\SIEMENS\STEP7\Example\exproj01 .1EA: successfully exported. 

Figure 4-4 

4-8 

Dialog box after export is complete (example) 
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Import-Export-Assistant 

The log window is divided into three columns: 

Manual Engineering System (ES) 
C79000-G7076-C711 -02 

Location 
This shows which object is affected. The "location" is the HID. 

Class 
This indicates whether it is an "Action" or an "Error". 

- Log text 
This indicates what the action does or the cause of the error. 
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Import-Export-Assistant 

4.2 Import 

Plant planning 
data 

File format 

CSV file 

Functional units 

Specimen 
solutions 

Import data 

4- 1 0  

A great deal of data is used during plant planning and some of this data 
occurs before a decision has been taken to opt for a specific control system. 
The import function enables this data to be used for control system 
engineering. 

The import data is available as files in CSV format. The CSV format is 
supported by many applications (Excel, Access, etc) and is based on ASCII. 
This makes it an excellent general data interface between any planning tool 
and the ES. The lEA expects these files to have the extension .lEA 

The file is structured as a table and is made up as follows: 

- the columns correspond to the various parameters and signals e.g. 
upper limit, lower limit, sensor, etc. 

- each row corresponds to a PICS unit, e.g. pressure control in a boiler. 

A plant is generally structured by dividing it into smaller functional units 
which can be classified, e.g. fixed setpoint controls, motor control units. 

Rather than recreating these functional units every time, you can create a 
stock of prepared functional units which then simply have to be copied and 
modified for the new system. 

In the ES, there must be a suitable specimen solution for each functional unit 
used in the plant, e.g. a hierarchy container with a CFC chart containing the 
fixed setpoint control and a WinCC image for operating and monitoring the 

fixed setpoint control. 

An lEA file is created for each different functional unit used in the plant. 

The following data is imported: 

• Higher level designation of the function (corresponds to the plant view) 

• Parameter descriptions for the functional units used 

• Signal descriptions for the signals used by the functional units 
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Procedure 

Import dialog 

Import-Export-Assistant 

To import: 

• Link each different specimen solution to the associated lEA file 

• Start the import process 

The import dialog comprises the following steps that are displayed by the 
lEA as successive sub-dialogs: 

• Specimen solution: Select parameters and signals 

• Assign import data structure to the parameters and signals of the 
specimen solution 

• Carry out the import process 

4.2.1 Configuring specimen solutions 

1. Sub-dialog 

Select parameters 
and signals 

Once you have activated the import function in the first sub-dialog, the lEA 
reads in all the block 1/0s of the specimen solution for the selected plant 
hierarchy container. A dialog box with the specimen solution table appears 
on screen (see Figure 4-3). 

Note 

If you modify the parameter or signal 1/0 points specified in the specimen 
solution, this will affect the assignment of the data structure of an 
import/export file (if one has already been assigned). If this occurs, a 
warning will appear on screen.lf you click on "OK" to confirm, the 
assignment will invalidated and will have to be recreated in the "Assign 
import data structure to specimen solution" sub-dialog. 
These changes will not affect specimen solutions that have already been 
copied or generated by importing. 

In the first sub-dialog you determine whether the block 1/0 concerned is to 
be used as a parameter or signal 1/0 point. Click on the check box in the 
"lEA para" or "lEA signal" column to select the block 1/0. The lEA will not 
allow you to select both columns at the same time since a block 1/0 cannot 
be both a parameter and a signal 1/0 point. An "X" is set in the check box 
and the text in that row will be highlighted in colour ("blue" for parameter, 
"green" for signals). 
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Import-Export-Assistant 

4.2.2 Assigning an import data structure to the specimen solution 

2. Sub-dialog 

4- 1 2  

The second sub-dialog is used to assign the data of the import file to the 
specimen solution data. The dialog box contains a list of column headers for 
the parameters and signals in the import file. The assigned data appears in the 
list of specimen solution data under the "Parameter I Signal" heading. 

The assignment ensures that, during the import process, the "right" data can 
be written to the "right" block 1/0s. 

Between the fields in the list, there are buttons which are used to assign the 
import data to the specimen solution data. 

">" This is used to assign the selected column header to the selected 1/0 
point. 

"<" This is used to return the assigned column header for the selected I/0 
point to the "Import data" list and cancel the existing assignment. 

"<<" This is used to return all assigned column headers from the "Specimen 
solution data" list to the "Import data" list and to cancel all existing 
assignments. 

Alternatively, you can drag and drop the column header assignments. 

For the import process, all the column headers must have been assigned and 
there must be no remaining I/0 points that have not been assigned (complete 
1:1 assignment). 
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Import-Export-Assistant 

4.2.3 Carrying out the import process 

3. Sub-dialog 

Complete 

Exit 

Click on "More >" to open the "Carry out import process" sub-dialog. A 
dialog box will be displayed containing the entry for the assigned import file 
and the selected log file. 

Click on the "Enter signals in symbol list" check box to enter the signal 
descriptions into the symbol table for resources of the hierarchy container 
concerned as well. This will also assign the specimen solutions copied during 
the import process to suitable input and output signals. 

Click on the "Complete" button to start the actual import process. Depending 
on how you have set the "Filter" c�eck boxes, the log window will contain 
either the complete list or only any errors that have occurred. 

This function may take a long time to execute, depending on the scope and 
complexity of the data to be imported. 

Once the "Complete" function has been executed, the button changes to 
"Exit". Click on this button to leave the "Import dialog". 
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Import-Export-Assistant 

4.3 Export 

Data for control 
system 
engineering 

Export d ialog 

4-14 

Specimen solutions are modified during control system engineering. This 
will also affect data programmed with other tools during the plant planning 
stage that was imported for the control system engineering stage. The 
following applications may arise: 

• If you want to compare plant documentation with the currently 
programmed data, then you should export the current data for the 
specimen solutions created by importing, in the same format as was used 
to import. 

• You can export the data for the plant configured with specimen solutions, 
re-edit this data using other tools (e.g. Excel or Access) and then import it 
again. This enables you to make changes in the project quickly and easily. 

The following data is exported: 

• Higher level designation of the function (corresponds to the plant view) 

• Current parameter descriptions for the specimen solutions 

• Current signal descriptions for the control system input/output signals and 
their links to the specimen solutions 

The export dialog comprises the following steps which are displayed by the 
lEA as successive sub-dialogs: 

• Select specimen solution for export 

• Structure and create export file (edit column headers) 

• Carry out export process 
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Import-Export-Assistant 

4.3.1 Select specimen solution 

1. Sub-dialog 

Select parameters 
and signals 

Once you have selected a hierarchy container and activated the export 
function, the lEA reads all the block 1/0s of the specimen solution for the 
selected plant hierarchy container. A dialog box with the specimen solution 
table appears on screen (see Figure 4-3). 

Note 

If you modify the parameter or signal 1/0 points specified in the specimen 
solution, this will affect the assignment of the data structure of an 
import/export file (if one has already been assigned) . If this occurs, a 
warning will appear on screen. If you click on "OK'' to confirm, the 
assignment will be invalidated and will have to be recreated in the "Structure 
of export file" sub-dialog. 

This recreated assignment will only affect the current specimen solution, and 
any other hierarchy containers created by importing will remain unchanged 
and, in this case, will not be exported. 

In the first sub-dialog you determine whether the block 1/0 concerned is to 
be used as a parameter or signal I/O point. Click on the check box in the 
"lEA para" or "lEA signal" column to select the block 1/0. The lEA will not 
allow you to select both columns at the same time since a block 1/0 cannot 
be both a parameter and a signal I/O point. An "X" is set in the check box 
and the text in that row will be highlighted in colour ("blue" for parameter, 
"green" for signals) . 
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Import-Export-Assistant 

4.3.2 Structure and creation of the export file 

2. Sub-dialog 

Structure of the 
export file 

While the export file preview is being prepared, a dialog box appears on 
screen to indicate the time remaining. The operation can be cancelled, if 
necessary. 

The "Structure of export file" dialog box will appear on screen. This dialog is 
used to change the column headers, although you must first have selected a 
specimen solution. If the file contains other copies of a specimen solution 
(several rows), the boxes for the column headers will be greyed out and 
cannot be changed. 

A column and header is created for each parameter and signal 1/0 point. 

The file is an ASCII text file in CSV format. The first row contains the 
column headers; the second row contains the information that tells the lEA 
how to interpret the columns. 

H\ 
p 
s 
I 

Hierarchy and separator for the hierarchical levels 
Parameter description 
Signal description 
Separator (e.g. between parameter value, designation 
and unit) 

All the other rows contain data. One row is output for each HID of a 
specimen solution with the same assignment to the import/export file. 

4.3.3 Exporting data 

3. Sub-dialog 

Complete 

Exit 

4- 1 6  

Click on "More >" to open the "Carry out export process" sub-dialog. A 
dialog box will be displayed containing entries for the assigned export file 
and the selected log file. Click on the "Other export file ... " button to call the 
browser in order to select or create another file for export. 

Click on the "Complete" button to start the actual export process. Depending 
on what you have set the "Filter" check boxes, the log window will contain 
either the complete list or only any errors that have occurred. 

This function may take a long time to execute, depending on the scope and 
complexity of the data to be imported. 

Once the "Complete" function has been executed, the button changes to 
"Exit". Click on this button to leave the "Export dialog". 
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4.4 Edit 

Call dialog 

Sub-dialogs 

Import-Export-Assistant 

The "Edit" dialog is used to put together your specimen solution. To do this, 
select, from the project, the container of the plant hierarchy containing the 
charts with block 1/0s that you want to edit. 

From the "Options" menu, select the "Import/Export Assistant" function and 
then select the "Edit" function from the submenu. 

This will start the search process in the lEA and the first dialog box will 
contain all the block inputs that have not been interconnected and all the 
outputs from all the charts in list format. Figure 4-3 shows an example with 
the parameters already selected. 

The entire "Edit" dialog consists of four sub-dialogs that are called one after 
another ("More" button): 

1. Select parameters and signals 

2. Enter parameter description 

3. Enter signal description 

4. Save the changes 
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Import-Export-Assistant 

4.4.1 Selecting parameters and signals 

1. Sub-dialog The first sub-dialog is used to determine whether the block 1/0 concerned is 
to be used as a parameter or signal I/O point. Click on the check box in the 
"Parameter" or "Signal" column to select the block 1/0. The lEA will not 
allow you to select both columns at the same time since a block 1/0 cannot 
be both a parameter and a signal 1/0 point. An "X" is set in the check box 
and the text in that row will be highlighted in colour ("blue" for parameter, 
"green" for signals). 

Note 

Since the properties lEA para and lEA signal are used by all three functions, 
if you change one of these properties, it will affect the assignment of the data 
structure of an import/export file. If this occurs, a warning will appear on 
screen. If you click on "OK" to confirm, the assignment will be invalidated 
and will have to be recreated in the "Structure of export file" sub-dialog. 

This recreated assignment will only affect this specimen solution and any 
other hierarchy containers created by importing will remain unchanged and, 
in this case, will not be exported. 

4.4.2 Entering the parameter description 

2. Sub-dialog The second sub-dialog is used to enter or modify the parameter values for the 
selected 1/0s. The list also contains the selected signal 1/0 points, although 
they cannot be edited. Only the parameter 110 point columns with a white 
background can be edited. 

- Value 

- Unit{fextO 

- Desig.{fextl 

Figure 4-5 Dialog box (section) with the table of selected parameters and signals 

4-1 8  
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Import-Export-Assistant 

4.4.3 Entering the signal description 

3. Sub-dialog The third sub-dialog is used to enter or modify the signal names for the 
selected 1/0s. The list also contains the selected parameter 1/0 points, 
although they cannot be edited. Only the signal I/O point columns with a 
white background can be edited. 

- Signal name 

- Unit/TextO 

- Desig./Textl 

Depending on the data type of the block 1/0, "Unit/TextO" and 
"Desig./Textl" may have different meanings. 

Table 4-1 Meaning of the columns according to the data type 

Data Type Unit/TextO Desig./Textl 

Bool Text for value "0" Text for value "1" 

All others Unit, e.g. kg Designation, e.g. setpoint 
value 

Note 

If properties have been assigned to a block 1/0 point, you must enter at least 
one signal name. 
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Import-Export-Assistant 

4.4.4 Saving the changes 

4. Sub-dialog 

Complete 

Exit 

4-20 

The fourth sub-dialog is used to save the parameter and signal descriptions 
you entered in the previous sub-dialogs and to make various settings, such as 

• Enter signals in symbol table: 
This check box is used to determine whether the signal descriptions 
should be entered at the signal I/O points of the CFC blocks only or in the 
symbol table as well. 

• Log file: 
The "Log file" field contains the path of the log file to which all 
operations, including any errors which occur, are written. If you have not 
yet created a log file or have specified one which you do not want to use, 
call the dialog for selecting or creating new files by clicking on the 
"Browse ... " button. 

Click on the "Complete" button to start the actual save process. Depending 
on how you have set the "Filter" check boxes, the log window will contain 
either the complete list or only any errors that have occurred. 

Structure of the log window: see "Complete" in Section 4.3.3. 

Once the "Complete" function has been executed, the button changes to 
"Exit". Click on this button to leave the "Edit dialog". 
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PLC and OS-independent configuration 5 

Overview 

In this Chapter 

This chapter describes the parts of engineering that are required for the 
overall configuration of a plant and provides an overview of the connections 
and interaction between the individual components, such as the PLC and OS, 
in the PCS 7 control system. 

This chapter deals with the following topics: 

Section Topic Page 

5.1 Configuring links between PLC and OS 5-2 

5.1.1 Preparatory work in the S7 project 5-2 

5.1.2 Special object properties 5-3 

5.1.3 Transfer to the OS 5-4 

5.1.4 Configuring the OS 5-4 

5.1.5 WinCC properties with the SI�IC Manager 5-4 

5.1 .6 WinCC properties with the CFC editor 5-5 

5.2 Message Planning 5-7 

5.2.1 Create block-related message type 5-7 

5.2.2 Create block-related message 5-8 

5.3 Visualize SFC on OS 5-10 

5.3. 1  SFC in the WinCC run-time system 5-10 

5.4 Transfer configuration data 5-11 

5 .5 Block types for S7 5-12 

5.6 Creating block types 5-14 

5.6.1 The system properties 5-17 

5.6.2 System properties for a specimen block 5-23 

Manual Engineering System (ES) 
C79000-G7076-C71 1 -02 5-1 www . 

El
ec

tric
alP

ar
tM

an
ua

ls 
. c

om
 

www . 
El

ec
tric

alP
ar

tM
an

ua
ls 

. c
om

 



PLC and OS-independent configuration 

5.1 Configuring links between PLC - OS 

Overview 

Installation 
requirements 

The PLC - OS link configuration is used to create, even during PLC 
configuration, the data required on the WinCC OS for communication 
between the PLC and OS, and thus for operator communication and 
monitoring. This data is transferred to one or more destination OSs, where it 
is used by graphics objects or display driver blocks. 

The data is saved as properties of the PLC objects, and is copied, moved and 
even deleted together with these objects. The assignments made for an FB, 
when it is inserted into a chart, will be inherited by the instance DBs, where 
they can be modified if necessary. You only have to enter the data once, even 
if you want to access the same PLC block from several OSs. 

To create one or more WinCC OSs within the same STEP? project, WinCC 
must be installed. For transfer purposes, you will also require the 
"PLC<->OS Engineering 2" software package. 

5.1 .1 Preparatory work in the 57 project 

Preparatory work 
on the OS 

5-2 

In order to be able to operator or monitor blocks, flags or 1/0 signals on the 
OS, you must carry out the following preparatory work during the 
configuration stage: 

• in the S7 project, give unique names to the S7 programs 

• at the FB, set the system properties for all OS-related block I/Os (see 
section 5.6.1): 

- S7 m c 

- S7 _shortcut and S7 _unit for analog data types 

- S7_string_O and S7 _string_l for binary data types 

Block with messaging characteristics: 

- S7 _server for the server assignment 

- S7 _a_type for the type of message I archive block 

• Import the FB (implicitly or explicitly) into the CFC and generate CFC 
instances by inserting the FB into the chart 

• If necessary, define OS-related symbols (flags, I/0 signals) 

• create one or more OSs in the S7 project 
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PLC and as-independent configuration 

5.1 .2 Special object properties 

Determining the 
special object 
properties 

Restrictions 

Some of the special object properties of a PLC object are determined 
automatically from data that you have already entered at another point in the 
project. Other object properties are entered using a dialog (see sections 5.1.5 
and 5.1.6.) 

The automatically determined data includes the names and data types of 
block 1/0s or symbols, the addresses of DBs and the offsets of block 1/0s, 
plus the texts you have entered via system properties. 

The name shown in the dialog is the same as the name created when the 
variables were transferred. It is composed of the following: 

- S7 _program_name_symbol . 

S7_program_name_DB_no 

- S7_program_name_symbol_name of the DB 

S7 _program_ name_ CFC _chart_ name_ CFC _block_ name 

- Plant hierarchy_ CFC _chart_ name_ CFC _block_ name 

The "underline" character in parts of names is not permitted since it is used 
as a separator in the path name. 

The name may also not contain the following characters since WinCC works 
in on-line mode: 
' \ + - * I and space 

For special functions in WinCC, other restrictions should be note (see WinCC 
documentation /301/ to /304/). 

Note 

Please note that name changes can also be caused implicitly, e.g. by changes 
to the assignment in the plant hierarchy. 
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PLC and OS-independent configuration 

5.1 .3 Transfer to the OS 

Before transfer 

Transfer to the OS 

Since some of the data stored in the special object properties indicates the 
status of the S7 project, e.g. as it was at the time a block was instantiated, 
adjustment functions must be run before the transfer. Adjustment is not 
required if you have not made changes to names, addresses or texts in the 
system properties since the last transfer. 

Once you have completed all the preparatory work, you can then transfer the 
configuration data to the OS (see section 5.4). When you transfer to the 
destination OS, the variables required for communication between the PLC 
and OS are inserted into the stock of variables of WinCC. The names of these 
variable are the same as the names displayed in the special object properties 
dialog. 

For a block, a structured DM variable is created, whereas symbols receive a 
simplified DM variable. 

5.1 .4 Configuring the OS 

OS images In parallel with and independently of the PLC configuration, you can also 
configure the images in the OS and insert graphics elements and display 
blocks. However, you cannot interconnect them with DM variables until 
these variables have been created by the transfer, since the interconnection 
dialog displays the available DM variables. 

5.1 .5 WinCe properties with SIMA TIC Manager 

Call dialog 

5-4 

The WinCC properties for FBs can be configured in STEP 7 with STL, LAD 
and FUP. Call the dialog via SIMATIC Manager. The procedure is described 
in detail in STEP 7 User Manual /231/. Block creation is also described in 
section 5.6. 

Note 

If the block was generated in the CFC, i.e it is a CFC generated object 
(generator designation CFCJSFC at the DB), you can only call the dialog via 
the CFC editor. 
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PLC and DB-independent configuration 

5.1 .6 WinCe properties with the CFC editor 

Call the OS 
dialog in the CFC 

WinCe properties 

A CFC chart is opened. In the "Object Properties" dialog box which you 
select by double-clicking on the block concerned, in the bottom part of the 
"General" index, set the "Special Object Properties" field with the "Can be 
operated and monitored" check box and the buttons for "Operator Control 
and Monitoring .. . " and "Message .. . ". If you click on "Operator Control and 
Monitoring .. . ", you will obtain a new dialog box containing the "General" 
and "WinCC Properties" registers. 

You can also reach the "Operating and Monitoring" dialog box by selecting a 
block using the "Special Object Properties" function in the "Edit" menu and 
then clicking on the "Operator Control and Monitoring . . .  " function in the 
sub-menu. 

In the "General" index, you will see, under "Name", the block names 
together with the full paths. If the chart has been assigned to the plant 
hierarchy, then enter the names of the hierarchy container, the chart and the 
block at this point. If you have not yet assigned a plant hierarchy, then 
specify the path of the standard hierarchy (component view). 

The text in the "Comment" box is additional information on the block. You 
can edit this text. 

The "Description" field displays information that has been generated by the 
system. You cannot change this text. 

The "WinCC properties" index contains a table with all the OS-related 
parameters. The order of the parameters corresponds to the order of the block 
I/Os, although only for the OS-related parameters. 

Note on the terms "parameter" and "block 1/0": 

The same objects are given different names by different groups of users. The 
term parameter used in the OS dialog and in the "world of programming" 
for the block inputs and outputs is also known as a block 1/0 in the "control 
system world". In the message planning dialog, you will also see the 
designation formal parameter. In the terminology of the "world of blocks" 
there is also the generic term for inputs and outputs:l/0 terminal strip. 

If it is an OS property of a symbol, the table will have only one row, since 
symbols are not structured any further. 
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PLC and DB-independent configuration 

Table of 
WinCe properties 

The table contains 12 columns and only part of this table can be displayed in 
the view window. You can move the visible pane using the horizontal 
scrollbar (or by moving the mouse pointer horizontally to the right or left, 
over the edge of the window). The "Parameter" column is always visible. If 
the table contains more parameters than can be displayed on a single page, a 
vertical scrollbar will be displayed as well. 

Table 5-1 WinCC properties 

Header Content of the column (meaning) 

Parameter Name of the block 1/0s or symbol 
names 

PLC data type Data type of the parameter 

OS data type Data type used by WinCC for 
displaying the parameter 

Format Operations used by WinCC to convert 
adjustment the PLC data type into an OS data type 

Length Length of the OS data type (in bytes) 

UL Upper limit for displays 
(e.g. bars) and measured values 

LL Lower limit for displays 
(e.g. bars) and measured values 

Starting value Default selection for the WinCC 
display 

Substitute value Substitute value. This is used with 
certain events during operator 
communication and visualization; 
in conjunction with "Use substitute 
value if' 

Use substitute >UL Upper limit reached 
value if <LL Lower limit reached 

Start as a starting value 
Cerror Connection error 

Generate log UL Upper limit exceeded 
entry if <LL Lower limit exceeded 

CON error Conversion error 
SAppl Write access to an 

application 
Sprocess Write access to a 

process 

5-6 

Variable 

No 

No 

No 

Yes 
Enter via the combination box or edit 
using the keyboard. 

No 

Yes, if the OS data type is not a text type. 
Click in the selection box to activate and 
edit the value. 

Yes, if the OS data type is not a text type. 
Click in the selection box to activate and 
edit the value. 

Yes, if the OS data type is not a text type. 
Click in the selection box to activate and 
edit the value. 

Yes, if the OS data type is not a text type. 
Click in the selection box to activate and 
edit the value. 

Yes, if the OS data type is not a text type. 
Click in the selection box to activate 
Condition: "Substitute value" must have 
been activated 

Yes, if the OS data type is not a text type. 

Click in the selection box to activate 

Condition if >UL I <LL: 
UL I LL column has been activated 
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PLC and OS-independent configuration 

5.2 Message planning 

Blocks capable 
of signalling 

Create message 
instance 

Message planning 

Transfer 

Control system-related block can be made capable of signalling. To do this, 
the block must always have the OS property. 

When a block with messaging characteristics is inserted into the CFC chart, 
the message server will automatically create a message instance. This block 
has a message structure with preset properties and message texts, i.e. when 
an event occurs, the corresponding message will be sent by the PLC without 
any further configuration. However, the properties and texts can also be 
edited to suit a specific block with the message planning facility. 

Message planning is used to create and edit event-independent messages and 
message types with assigned texts and properties. The message type is 
created for an FB (see 5.2.1). The messages configured for this message type 
are used as the template for any blocks instantiated by it. With the instance 
DB, you can modify the messages that were generated from the message type 
for specific instances. 

In connection with message planning, you transfer the generated data to the 
stock of variables of the OS (see section 5.4). 

5.2.1 Create block-related message type 

Block capable of 
signalling 

Create message 
type dialog 

The message typeis created for an FB. Requirement: the FB must have been 
created as a block capable of signalling, i.e. the system properties "S7 _server 
= alarm_archive" and "S7 _a_type = alarm block'' must have been assigned to 
the block 1/0s concerned (alarm block = alarm_ 8, alarm_ 8p, notify, alarm, 
alarm_s, ar_send). See also section 5.6.2, System properties for a specimen 
block. 

Select the FB from the blocks container and call the message planning dialog 
(Edit -> Special Object Properties -> Message ... ). You will see that this is a 
message type because the detailed window for the formal parameters 
contains no message numbers. 

In the rest of the dialog, create a general message that can be output, as 
standard, to all display devices. (For a description of the configuration 
dialog, (see section 5.2.2) 
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PLC and OS-independent configuration 

5.2.2 Create block-related message 

Start configuration To configure the message, double-click on the alarm block to open the 
"Object Properties" dialog box. In the bottom part of the "General" index, 
you will see the "Special Object Properties" box with the "Message ... " 
button.Click on "Message ... " to open a new dialog box (Figure 5-1). 
Alternatively, you can also start the "Message ... " function for the selected 
block with the "Special Object Properties" function from the "Edit" menu. 

If the "Message .. . " button in the "General" card index or the "Message ... " 
command in the menu is greyed out, the selected block is not a block with 
messaging characteristics. 

Figure 5-1 "Message planning" dialog box 

Dialog for 
message planning 

5-8 

When a block has been selected from the directory structure (left-hand box), 
the detailed view (right-hand window) contains the following columns: 

• Formal parameter 
Name of the block 1/0 assigned to an alarm block. 
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Detailed 
description 

PLC and OS-independent configuration 

• Alarm block 
Type of alarm block. There are single channel (Alarm, Alarm_s, Notify) 
and multi-channel (Alarm_8, Alarm_8p) alarm blocks. The designation is 
the name of the alarm block that was assigned to the block 1/0 with 
system property "s7 _a_ type". 

• Message number 
Number for identifying the alarm or group of messages. The message 
number is automatically allocated for block-related messages (for DB). A 
message type (for FB) has no message number. 

Configuring without assigning devices: 
Select the block 1/0 to be edited by single clicking on its formal parameters. 
For single-channel alarm blocks, you can now enter the properties and the 
message text directly into the "For the general message" box. The properties 
are display classes 0 to 16 and the acknowledgement type "Fault message" or 
"Operator message". 

For multi-channel blocks, you can enter the properties "For a group of 
messages" and, once you have opened the directory for this block 1/0 (click 
on the + box), you can enter properties and message text "For the general 
message within a group" for each of the sub-numbers (1 - 8). 

Assign device 
If you select a block 1/0 with a single-channel alarm block, then you can 
click on the "New Device" button to open a dialog box in which you can 
assign the display device (OP25, OP35, WinCC) and set the device 
properties. In the case of a block 1/0 with a multi-channel alarm block, you 
must first open the directory and then select the sub-number before you can 
assign a device. 

Configuration for WinCC 
The properties that can be set for WinCC are the 

• Messagge class 
(e.g. alarm, warning, tolerance, PLC control system alarm, etc) 

• Message type 
(e.g. fault, error, above, below, etc) 

• Type of acknowledgement 
(Single message, group message) 

In the "Text" index, you can edit up to 10 message texts and, in the 
"Infotext" index, you can add a text as additional information. 

A detailed description of the message planning procedure and a description 
of the objects and planning methods are given in the On-line Help on 
message planning. 
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PLC and OS-independent configuration 

5.3 Visualize SFC on OS 

Transfer chart In order to be able to operate and monitor SFC functions in on-line mode 
(run-time) from the OS, the the necessary data must first be generated and 
transferred to the OS. See section 5.4. 

5.3.1 SFC in the WinCe run-time system 

Call SFC chart 

Overview window 

Detai l  window 

More detailed 
documentation 

5-10 

You can visualize the imported SFC charts in the WinCC run-time system. 
You must have the optional "SFC visualization" package 

The key set for the user interface has a dedicated key for calling the SFC 
chart. Press the "SFC" key to call a dialog box for selecting an SFC chart. 
Once you have selected and confirmed by clicking on "OK'', a window will 
be displayed in the working area of the user interface. Depending on the 
settings in the Control Center, this will either be the "Overview window" 
with the entire chart in compact format or the Detail window which shows 
the chart in detail. 

The chart elements (steps) are displayed in minimum size and the transitions 
are not displayed. The size of the overview window is varied to suit the size 
of the chart. The active steps are identified by colours. The name of the first 
active step is output above the chart topology. 

Click with the mouse within the Overview window to open another detail 
window. This is the "detail window". This displays the (enlarged) are of the 
chart in which the mouse pointer was positioned. This shows all the chart 
elements in "normal size". However, you can change the size at any time 
(down to minimum size). 

The detail window contains all the controls required to visualize steps and 
transitions and for issuing commands, switching modes and the options for 
using the chart. 

A more detailed description of the visualization and operator input options 
can be found in the WinCC On-line Help and the WinCC User Manual for 
the run-time system /304/. 
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PLC and OS-independent configuration 

5.4 Transfer config uration data 

Call transfer dialog 

Comparison 

Transfer 

Select the "Transfer configuration data" function from the SIMATIC 
Manager "Options" menu to open a dialog box and then select the desired OS 
the the project from the OS-CPU assignment. 

When you select the OS, you can also specify the transfer mode in the dialog 
box (delta or complete) and set the transfer options (see Figure 5-2). 

Before the transfer, you should compare the addresses, text and names. 

The data will not be transferred to the OS unless you have checked the 
"Variables and messages" check box. 

Click on "OK" to start the generation process, followed by the transfer to the 
selected OS. 

Figure 5-2 ''Transfer configuration data" dialog box 

This will transfer the configuration data to the stock of variables of the OS. 
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PLC and DB-independent configuration 

5.5 Block types for S7 

Overview 

Differentiating 
between block 

Driver blocks 

5-12  

The block types used in PCS 7 can either be purchased in the form of  block 
libraries or you can create them yourself. You can also supplement the 
existing stock of block types if necessary. 

At this point, we particularly recommend using the basic blocks and the 
Reference Manual /258/, which also provides a detailed description of the 
block concept (Chapter 2). 

You can also make use of the libraries of technological blocks and field 
device blocks and their documentation /259/, /260/. 

We differentiate between 

- block types 

freely programmed S7 blocks 

- mapping objects 

A block type in the context of the type/instance concept is a block whose 
program code accesses only its own interface and instance data. Direct access 
to peripheral signals and global data is not permitted. The block types can be 
instantiated as often as required. 

Freely programmed S7 block can directly access peripheral signals and 
global data. The CFC editor does not prevent multiple instantiation - this is 
possible under the user's responsibility. 

Mapping objects are blocks which occur during SCL code generation for the 
ES (they can be identified in the detailed view under "Editor: CFC/SFC". 
Blocks generated in this way cannot logically be instantiated. 

Driver blocks are required for transferring process data between the 1/0 
peripherals and the processor blocks. These driver block form the interface to 
the hardware and also perform a testing function. 

During CFC planning, information such as subnet, rack and slot number, 
must be transferred to the driver block via the assigned module. This 
information can be take from the configuration table created during 
configuration with HWConfig. (You can call HWConfig and the table by 
double-clicking on the "Hardware" icon at the SIMATIC station.) 

In the case of redundant modules, you must also carry out the parameter 
assignment for the redundant module. 

For more detailed information on assigning parameters to driver blocks, see 
/258/, Chapter 5. 
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Transfer of the 
data 

PLC and OS-independent configuration 

The block interface description (but not the block code) is transferred to the 
ES database. This involves the following information: 

• Block type (FB, FC) and block number 

• Block name (from the symbol table) 

• Block comment (from the symbol table) 

• Block family 

• Description of the individual parameters 

- Address 

- Declaration (IN, OUT, etc.) 

- Name 

- Data type (BOOL, INT, etc.) 

- Start value 

- Comment 

- System properties 
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PLC and as-independent configuration 

5.6 Creating block types 

STEP 7 tools 

Differentiating 
between FB I FC 

Subsequent 
modification 

5-1 4  

S7 block types for the CFC can b e  created with the appropriate STEP 7 tools, 
e.g. STL, LAD, SCL editor. 
See /232/, /233/, /250/ of the STEP 7 documentation. 

When you create the block, you must specify whether you want to create an 
FB or an FC. Please note the following differences: 

• Select FB if you want to use the block for operating and monitoring and if 
you require a block with a "memory", i.e. if the data is to be available 
and ready for access over several cycles. A DB is created for each 
instance. 
It is possible to implement the FB with lower-level FBs (multi-instance). 
When it is instantiated, only an instance DB will be created. 

• Select the FC if you want to use functions for which the block does not 
require a "memory, i.e. if values generated by the block are to be used 
immediately. This applies to all basic operations, such as AND; NAND, 
etc. An FC has no default values at the outputs. No instance DB is 
created. 

When you create the block type, you should have taken account of what the 
block type is to record. Modifying block types that have already been used 
can be a very time-consuming operation. 

Note 

If block types that have already been used in the CFC are subsequently 
modified (e.g. in the S7 tool SKA), there will be inconsistencies with the 
CFC planning. 
Inconsistencies can also occur if structural changes are made to Block Types 
that have already been used in the OS. 

The block consists of the 1/0 terminal strips, the static data and the code for 
the algorithm. If you modify the block, this means: 

• You can modify the algorithm for the block type at any time in the 
"Blocks" container. 

• You can modify the static data, e.g. by adding additional data. However, 
you must then recompile the CFC chart to ensure that the new instance 
DBs are created. 
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Please note 

Properties 

PLC and OS-independent configuration 

• To modify the 1/0 terminal strips, proceed as follows: 

Delete all instances of the type and the block type 

modify the block type in the language in which it was created 

import back to the CFC 

reconfigure all the instances 

When you create the block types, the block name (as displayed in the 
"object properties" dialog box) is of no relevance for the CFC since, as with 
the comment, it is taken from the symbol table. If there are no entries in the 
symbol table, then the name will be formed from the type and the number, 
e.g. FBJOO. 

The keyword FAMILY and a string of characters ( <= 8 characters) is used to 
designate the block family, e.g. LOGIC. This block family is the sort 
criterion in the CFC block catalog (tree view). 

For block 1/0s (block inputs I outputs also known as the block interface), the 
parameters IN, OUT and IN_ OUT must be taken from the declaration table 
with the parameter name, data type, starting value and comment 

Restrictions: 
The types STRUCT, ARRAY and BLOCK_SDB may not be used for CFC 
blocks. 

In addition to the existing block interface description, you can assign other 
properties to the blocks. These are defined as system properties and are used 
for FB, FC, SFB, SFC. 
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PLC and OS-independent configuration 

5-1 6 

The properties can be accessed via the block properties. System properties 
are: 

Task list 
This is used to specify in which tasks the block is to be automatically 
inserted by the CFC. 

Display type 
We differentiate between two display types: 
In the large display, the block with the parameter names for the inputs 
and outputs is mapped in the small display without parameter names. 

Properties for block 1/0s, such as: visible I invisible, can be made 
dynamic, interconnected, assigned parameters and operated. 

Operating and Monitoring 
For block types with usable inputs, you can specify the operating text, 
which can be individually modified for each instance. 

Warning: If this parameter is modified, the instance should be deleted 
and recreated so that the equivalent structure is created on the OS. 
The operator message text is transferred to the OS, but is not loaded 
onto the PLC. 

Signalling 
You can pre-specify default message texts for the block types. These 
can be modified for each instance. The message text is transferred to 
the OS, but is not loaded onto the PLC. 
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PLC and DB-independent configuration 

5.6.1 The system properties 

General on the 
system properties 

System properties 
for multiinstance 
blocks 

User interface 

Testing the input 

Default setting 

The number of system properties per block is unlimited. 

When you edit the properties, ensure that the keyword: 

- starts with the prefix "S7 _" 

- is written in lower case (key and value. The only exception is the 
prefix "S7 _") 

- always has a value. It is not sufficient simply to specify the key. 

When you create an FB with lower-level FBs (multiinstance), only the 
"parent" is of importance for the system properties, i.e. the system properties 
of the local instances ("children") are no analyzed and are thus not inherited 
by the instance DB. 

Creating multiinstance blocks: see /250/. 

The system properties are entered via the block properties. The "Properties" 
dialog box contains several indexes. The "Properties" index contains a table 
with two columns: the first for the keyword and the second for the value. 

The entered properties are tested for correct syntax, length (key: 24 
characters, value: 254 characters) and for uniqueness (a property may only be 
entered once per block 1/0). 

Do not enter the system properties unless you want to modify or add to the 
default setting. 

We shall now describe the system properties that can be used in the CFC. 
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PLC and OS-independent configuration 

S7 _tasklist 

S7 _blockview 

S7_visible 

5-1 8  

Inset into several tasks 

With this property, the CFC can identify whether a block is to be inserted 
into several tasks. The task list is taken from the property. 

In S7, you should always use the OB no. as the task name since the symbol 
for the task can be modified as required. However, if no valid OB no. is 
found, the task name will be interpreted as the symbolic name. 

For all other CFC PLCs (e.g. M7, SIMADYN D), the symbolic name is 
expected in the S7 _tasklist, e.g. 'restart'. 

Values: S7 _tasklist:='tasknamel,taskname2, ... ' 

Can be modified for each No 
instance: 

Default: Block will not be inserted several times 

Please note: The block will be inserted into the tasks contained in the task 
list if they were also present in the chart container at the time of import. Any 
tasks not present will not be included and no message will be issued. 

If you work with the symbolic names for tasks then, during the import, the 
associated OB will be determined from the symbol name. The block will be 
inserted into this OB. If the name of the OB is subsequently modified, this 
will have no effect since it is the OB name at the time of import that is used. 

Displays the block 

With this property, the CFC can identify whether a block is to be displayed in 
large or small format. 

Values: S7 _ blockview:='big' 
S7 blockview:='small' 

Can be modified for each No 
instance: 

Default: S7 _ blockview:='big' 

Visible: Yes I No 

With this property, the CFC can identify whether the block 1/0 is to be 
displayed or not. 

Values: 

Can be modified for each 
instance: 

Default: 

S7 visible:='true' -
S7 visible:='false' 

Yes 

S7 visible:='true' 
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S7_param 

S7 link 

S7_dynamic 

PLC and OS-independent configuration 

Can be assigned parameters: Yes I No 

This property determines whether the block 1/0 can be assigned parameters 
in the CFC or not. 

Values: S7 _param:='true' 
S7 _param:='false' 

Can be modified for each No 
instance: 

Default: S7 _param:='true' 

Can be linked: Yes I No 

With this property, the CFC can identify whether the block 1/0 can be linked 
or not. 

Values: S7 link:='true' 
S7 link:='false' 

Can be modified for each No 
instance: 

Default: S7 link:='true' 

Can be made dynamic: Yes I No 

With this property, the CFC can identify whether the block 1/0 can be made 
dynamic during the testing/commissioning functions or not. 

Values: S7 _dynamic:='true' 
S7 _dynamic:='false' 

Can be modified for each Yes 
instance: 

Default: S7 _ dynamic:='false' 
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PLC and OS-independent configuration 

S7_m_c 

S7_m_c 
for 
block 

S7_m_c 
for 
block 1/0 

S7_server 

5-20 

The following properties are used for preparing functions for operating 
and monitoring. The property values can be used by WinCC or by 
user-written display driver blocks. 

This property can be used both for the block and for the block 1/0s. 

Block for operating and monitoring (OS): Yes I No 
With the property for the block, you can specify whether its instances can be 
operated and monitored (default behaviour). The property "Operating and 
Monitoring" can subsequently be modified for the instances (requirement: the 
block must have at least one block 1/0 with the property S7_m_c: =true). 

Values: S7 m c:='true' 
S7 m c:='false' 

Can be modified for each Yes 
instance: 

Default: S7_m_c:='false' 

Block 110 can be operated and monitored: Yes I No 
With this property, the CFC identifies which block 1/0s can be read from or 
written to the OS. Requirement: For the block 110 to be operated and 
monitored, the property for the block must be S7 _ m _ c: = 'true'. 

Values: S7_m_c:='true' 
S7_m_c:='false' 

Can be modified for each No 
instance: 

Default: S7 _m _ c:='false' 

Message planning 

With this property, the CFC identifies whether the block 1/0 is to be assigned 
to a message server. The message I archive number is signalled to the block 
1/0 by the server. 

Values: 

Can be modified for each 
instance: 

Default: 

S7 _server:=' alarm_ archiv' 

No 

No server call 
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S7_a_type 

S7 _shortcut 

S7_unit 

PLC and OS-independent configuration 

Type of message I archive block 
Requirement: S7 _ server:=alarm _ archiv 

With this property, it is specified for the block 1/0 whether is is a message 
number input (message type AlARM, AIARM_8, AIARM_8P, AIARM_8S 
or NOTIFY) or an archive number input (AR_SEND). The message server will 
identify from this for which type of alarm block or archive block an action is to 
be initiated (e.g. Instantiate message, Allocate number). 

Values: S7 _a_type:='alarm' 
S7 _a _type:=' alarm_ 8' 
S7 _a_type:='alarm_8p' 
S7 _a_type:='alarm_s' 
S7 _a_type:='notify' 
S7 _a_type:='ar_send' 

Can be modified for each No 
instance: 

Default: - -

Identifier for analog values 

The 16-character designation for analog values is allocated to the block 1/0 
and analysed in the display block and OS operator input listing. 

Values: S7 _ shortcut:='Setpoint value' 
(Examples) S7 _shortcut:='Manipulated variable' etc. 

Can be modified for each Yes 
instance: 

Default: Empty string 

Unit 

Up to 16 characters of text can be specified in order to display the unit of 
process values in the display block. This text is assigned to the block 1/0 and 
is analysed in the display block and OS operator input listing. 

Values: S7 unit:='Litre' 
(Examples) S7 unit:='m' 

etc. 

Can be modified for each Yes 
instance: 

Default: Empty string 
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PLC and DB-independent configuration 

S7 _string_ 0 

S7 _string_1 

5-22 

Operating text 0 for binary values 

Up to 16 characters of text are assigned to the block 1/0 and as the 1st 
operating text (e.g. for labelling the "OFF" key) in the display block and the 
OS operator input listing. In the CFC, the property is also used to display the 
statuses (in plain text). 

Values: S7 _string_O:='OFF' 
(Examples) S7 _string_O:='ON' 

etc. 

Can be modified for each Yes 
instance: 

Default: Empty string 

Operating text 1 for binary values 

Up to 16 characters of text are assigned to the block 1/0 and as the 2nd 
operating text (e.g. for labelling the "CLOSE" key) in the display block and 
the OS operator input listing. In the CFC, the property is also used to display 
the statuses (in plain text). 

Values: 
(Examples) 

Can be modified for each 
instance 

Default: 

S7 _string_l:='ON' 
S7 _string_l:='OF' 
etc. 

Yes 

Empty string 
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PLC and OS-independent configuration 

5.6.2 System properties for a specimen block 

Task 

System properties 

Property for block 

To create a block that can be operated and monitored and can also send 
messages. The block for this example should contain: 

• useable analog value 

• useable binary value 

• monitorable analog value 

• monitorable binary value 

(setpoint value SP _ OP) 

(for switching between operating 
modes MODE) 

(effective setpoint value SP) 

(effective operating mode 
QMODE) 

• signalling behaviour with ALARM_8P (message number EV _ID) 

SP OP SP 
Setpoint value-

Other formation 

parameters 

MODE QMODE 
Operating mode-

Other logic 
parameters 

ALARM 8 
Alarm r-- r--
parameters r-- r--

EV ID r-- r--
r-- r--

We shall now describe, for this specimen block, which system properties are 
used for the block and the block 1/0s. 

The following property is to be set for the block: 

S7 _m_c:='true' 

In the CFC, each instance of this block type will be enabled for operating and 
monitoring. This object property can subsequently be deselected for specific 
instances. 
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PLC and OS-independent configuration 

Properties for 
block 1/0s 

5-24 

The following properties are to be set at the block 1/0s: 

1. Analog input Setpoint value SP _OP 

S7 _m_c:='true' 

The input is now enabled for operating and monitoring. 

S7 _shortcut:='W=' 

S7 _unit:='rpm' 

This will create variables in the WinCC stock of variables with the text 
for the analog value abbreviation (W=) and for the unit (rpm). 

2. Binary input Switch between operating modes MODE 

S7 _m_c:='true' 

The input is now enabled for operating and monitoring. 

S7 _string_O:='Manual' 

S7 _string_l:=' Automatic' 

This will create variables in the WinCC stock of variables with the 
operating text for the operating modes (Manual, Automatic). 

3 .  Analog output Effective setpoint value SP 

S7 _m_c:='true' 

The output is now enabled for operating and monitoring. 

S7 _shortcut:='WW' 

S7 _unit:='rpm' 

This will create variables in the WinCC stock of variables with the text 
for the analog value abbreviation (WW=) and for the unit (rpm). 

4. Binary output Effective operating mode QMODE 

S7 _m_c:='true' 

The output is now enabled for operating and monitoring. 

S7 _string_O:='Manual' 

S7 _string_ I:=' Automatic' 

This will create variables in the WinCC stock of variables with the 
operating text for the operating modes (Manual, Automatic). 

Manual Engineering System (ES) 
C79000-G7076-C711 -02 www . 

El
ec

tric
alP

ar
tM

an
ua

ls 
. c

om
 

www . 
El

ec
tric

alP
ar

tM
an

ua
ls 

. c
om

 



General notes 

PLC and OS-independent configuration 

5. Input EV_ID for Alarm_BP block 

S7 _server:='alarm_arcbive' 

S7 _a_type:='alarm_8P' 

This will ensure that a message object can be created for the block and a 
message number will automatically be allocated when it is instantiated 
(assignment of the alarm in the OS). The default message texts for the 
block type will be configured at the message object. These can then be 
individually modified at each instance in the CFC. 

S7 _link:='false' 

S7 _param:='false' 

This will prevent the message number input being assigned parameters or 
linked in the CFC. 
Please note: We recommend that you always enter the properties 

(S7 _link:='false' and S7 _param:='false') for EV _ID. 

The message text available at the block type and the texts that can be 
assigned via properties (shortcut, unit, string_O, string_l) are default values 
which can be modified in the CFC for each instance. The corresponding 
dialog will be offered to the user if the block type can be operated/monitored 
and can send messages. 

When transferred to WinCC, the operating and display texts are entered into 
all the foreign language columns in the text library, where they can be 
modified using WinCC tools. 

In addition, several alarm blocks can be used in a block type. Consequently, 
each EV _ID parameter must be passed to the block's inputs and assigned 
properties. The message object will then automatically receive the same 
number of message texts. 
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Documentatio n  

Overview This chapter describes how to generate and use lists to document your 
planning structure (reference data) . . 

In this Chapter This chapter deals with the following topics: 

Section 

6.1 

6.2 

6.3 

6.3 .1  

6.3.2 

6.3.3 

6.3.4 

6.3.5 

6.3.6 

6.4 
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Topic 

Introduction 

Operation 

Cross References 

"Cross References for Addresses" list 

"Cross References for CFC 1/0s" list 

"Cross References for Runtime Groups" list 

"Cross References for SFCs" list 

"Cross References for Block Types" list 

"S7 Resource Assignment" list 

Tree structure of the "Run Sequence" 

6 

Page 

6-2 

6-3 

6-4 

6-5 

6-6 

6-6 

6-7 

6-7 

6-8 

6-9 
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Documentation 

6.1 Introduction 

Overview 

Different versions 

Different projects 

Documentation 

6-2 

The "Reference data" function is used to display and print cross-reference 
lists, the S7 Resource Assignment list and the Run Sequence: 

In this way, you can check your planning structure. For example, you can use 
the "Cross References of Addresses" list to check which memory markers are 
used how often and whether the write accesses are synchronized. 

You do not have to close the window containing the reference data if you 
want to continue working in the CFC. This means that you can view the 
generated lists while you are working in the CFC. 

Once a list has been generated, it will not be updated by the system again. 
Each list provides information on the project status at the time the list was 
generated. This has the advantage that you can document the different 
versions of a project. You can open several lists with different versions in 
parallel. 

You can not only generate lists of the project you are currently working on in 
the CFC. You can also access all the other CFC projects. This will enable you 
to compare several projects. Lists for several projects can be opened in 
parallel. 

Together with the printed charts, with the reference data, you will also obtain 
complete documentation of your planning structure. 
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6.2 Operation 

Calling and 
leaving the Editor 

Handling windows 

Create list 

Set Column Width 

Search 

Go to place of use 

Print 

Documentation 

Call the "Reference data" application from the current chart: 

Select "Options: Reference data" or click on the Reference data on the 
Toolbar. 
This will open the "Reference data" application. The last list to be started 
will appear on screen (e.g. "Cross References for Addresses") for the current 
chart. 

The "Window" menu contains various options for opening, arranging and 
closing windows. You can open several lists with different versions and for 
different projects in parallel. The window title will contain the logical path 
name for the chart container concerned. 

When you call the application, the last list to be started will be generated and 
displayed. Select the menu "View" or or the appropriate icon from the 
Toolbar to switch to the individual cross-reference lists, to the S7 Resource 
Assignment or to the Run Sequence. The list will be generated as soon as you 
switch over. 

In the lists, you can individually set the width of each column by positioning 
the mouse over the boundary between two column headers, holding down the 
mouse button and pulling the boundary to the left or right. 

Select "Edit: Search" to search for terms (strings of text) within the active 
window. The system will always search in every column. When a term is 
found, the position is displayed and highlighted. 

From the current list, you can double-click on the name in the first column or 
or select "Edit: Go to Place of Use" to open the chart containing the place of 
use. The block or chart element concerned will be highlighted. 

The printing functions in the "Reference data" application are contained in 
the "Reference data" menu. They are used in the same way as the printing 
functions of the CFC editor. It is always the list in the active window which 
is printed. 
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Documentation 

6.3 Cross References 

List of Cross 
References 

Please note 

Abbreviations in 
the lists 

6-4 

The following lists of reference data can be displayed and printed: 

• Cross References for Addresses 
The list contains all the global addresses and their accesses used in the 
project. 

• Cross References for CFC I/Os (with SFC only) 
The list contains the accesses to the CFC block I/Os from any SFC charts. 

• Cross References for Runtime Groups 
The list contains the accesses for all runtime groups from any CFC and 
SFC charts. 

• Cross References for SFC (with SFC.only) 
The list contains the available accesses from any SFC charts for all SFC 
charts. 

• Cross References for Block Types 
The list contains the block types used and the points (CFC chart) at which 
they are used. 

• S7 Resource Assignment 
The list contains the assignment between CFC planning objects and 
S7 resources. 

The list of "Cross References for CFCs" contains no cross references from 
CFC to CFC, since this corresponds to the interconnections between CFC 
charts and can be seen from the CFC documentation. 

Table 6-1 shows the abbreviations used in the cross-reference lists and their 
meaning. 

Table 6-1 Abbreviation for access types, actions and addresses 

Abbreviation 

L 

s 
-

X 

I 

B 

E 

L 

R 

Meaning 

Access type: read 

Access type: write 

Access: real (in the "Virtual" column) 

Access: virtual (in the "Virtual" column) 

Action: Initialize 

Action: Execute 

Action: Terminate 

Left-hand operand (of the assignment) 

Right-hand operand (of the assignment) 
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Documentation 

6.3.1 "Cross References for Addresses" l ist 

List structure This is a list of the global addresses used in the project and their accesses. 
Figure 6-1 shows the Reference data window with the list of cross references. 
Table 6-2 lists the meaning of the individual columns. 

!!it CFC/SFC Util: Display reference data- [pro1\anl1\reac3\tp2\\cross references O .. l!!liJ EJ 

Add�', ' 
AB16 BYfE s CFC-LaLi Recipe_ Conv3.0UT W_BY 

Figure 6-1 Reference Data: Address cross references 

Table 6-2 "Cross References for Addresses" list 

Column header Meaning 

Address Absolute address of the operand 

Symbol Symbolic address of the operand 
(entry in the symbol table) 

Data Type Keyword for the data type used 

R/W Read (R) or write (S) access 

Chart Path and name of the chart from which the address 
is accessed 

Chart element Name of the linked block and 1/0 or 
SFC element, action and number of the 
assignment 

Element comment Comment on the block I SFC element 

Type Type of chart element (block type in CFC (e.g. 
"PID") or element type in the SFC (e.g. "Step")) 
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Documentation 

6.3.2 

6.3.3 

6-6 

"Cross References for CFC 1/0s" l ist 

The list contains the accesses to block 1/0s from any SFC charts (steps and 
transitions) for all CFC charts. 

Table 6-3 "Cross References for CFC 1/0s" list 

Column header Meaning 

CFC Path and name of the CFC chart which is accessed 

1/0 Block and 1/0 name 

Type Block type (e.g. MUX8_R) 

Virtual x = SFC access to a CFC block which is not really 
present (- = real access) 

R/W Read (R) or write (S) access 

SFC Path and name of the SFC chart from which the 
address is accessed 

Zoom element Name of the linked SFC element, action and 
number of the assignment (e.g. step.B.005) 

Type Type of chart element (step or transition) 

"Cross References for Runtime Groups" l ist 

The list contains, for all runtime group, the accesses available (switching the 
runtime group on/off, status query) from any CFC charts (block 1/0s) and 
SFC charts (steps and transitions). 

Table 6-4 "Cross References for Runtime Groups" list 

Column header 

Runtime group 

Virtual 

R/W 
Chart 

Chart element 

Element comment 

Type 

Meaning 

Name of the group 

x = virtual access 
- = real access 

Read (R) or write (S) access 

Path and name of the CFC or SFC chart 

Name of the linked block and 1/0 or SFC element, 
action and number of the assignment 

Comment on the block I SFC element 

Type of chart element (block type in CFC (e.g. 
"PID") or element type in the SFC (e.g. "Step")) 
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Documentation 

6.3.4 "Cross References for SFC's" list 

The list contains, for all SFC charts, the accesses available (switching the 
chart on/off, status query) from any SFC charts (steps and transitions). 

Table 6-5 Cross references for SFC charts 

Column header Meaning 

SFC Path and name of the SFC chart which is accessed 

6.3.5 

Virtual x = SFC access to a CFC block which is not yet 
really present (- = real access) 

R/W Read (R) or write (S) access 

SFC Path and name of the SFC chart from which the 
address is accessed 

Zoom element Name of the linked SFC element, action and 
number of the assignment (e.g. step.B.005) 

Type Type of chart element (step or transition) 

"Cross References for Block Types" l ist 

The list of block types shows where these block types are used. This can be 
useful for management of blocks if, for example, before you delete a block 
type which you think is unused, you can check the Cross Reference list to 
identify whether this block type is used or not. 

Table 6-6 "Cross References for Block Types" 

Column header Meaning 

Block type Block type name (e.g. CTU) 
Chart Path and name of the CFC chart in which the 

block is used 

Block Name of the instance block (e.g. counter) 

Block comment Comment on the block (e.g. loop counter) 

Virtual x = SFC access to a CFC block which is not yet 
really present (- = real access) 
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Documentation 

6.3.6 "S7 Resource Assignment" l ist 

6-8 

The list contains the assignments between the configuration data and the S7 
resources, sorted by ES configuration object. 

Table 6-7 Cross References for S7 resources 

Column header 

Configuration object 

Element 

Type 

S7 resource 

Resource type 

Meaning 

Path and name of the object 
(e.g. CFC/SFC chart, group, OB) 

Block name and block 1/0 
(e.g. COUNTER.END) 
Step, action, assignment no. and address 
(e.g. START.B.002.R) 
Transition, condition no. and address 
(e.g. TIMER.Ol.R) 
Runtime groups enabled or disabled 
(e.g. EN or - )  

Type of chart element (block type, SFC, step, 
transition, runtime group, task) 

Name of the DB (even with OFFSET), FC, OB 
(e.g. DB 27 OFFSET 3 .5, DB 17, FC 9, OB 1) 

(e.g. instance DB, sequence DB, pool element, 
transition FC, action FC, task FC) 
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Documentation 

6.4 Tree structure of the "Run Sequence" 

List structure Figure 6-2 shows the run sequence of a CPU (tasks, runtime groups and 
blocks). 

� CFC/SFC U1il: Display reference data - [CFC_BSP\THB1\THB2\\Run_Sequence] I!!I;J E3 

I � 0830 a- -6,[ljl 0831 

: � _. SFC-LaU [2\0] 

:- -� 0832 

1- -® 0833 

I � 0834 

Iii- -� 0835 

El- � 0836 I ""'E  
I I -{I- CFC-LaU.Timer [TIMER_P] 
I 1- -{1- CFC-LaU.Conv_1 [R_TO_I] 

: r -e:J GRU3 [2\0] 

Figure 6-2 Reference Data: Sequence 

The designation of the objects means: 

-t@. 0833 

• 
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Technical Data 

In Appendix A Appendix A deals with the following topics: 

Section 

A.l 
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Technical Data 

A.1 Data Types 

Table A-1 Data types for the SIMATIC S7 system 

Abbr. 

A 

BO 

BY 

c 
CR 

D 

DB 

DI 

DT 

DW 

FB 

FC 

I 

p 
R 

s 
SD 

SN 

T 

TI 

TR 

T5 

w 

A-2 

Keyword 

ANY 

BOOL 

BITE 

CHAR 

COUNTER 

DATE 

BLOCK DB 

DINT 

DATE AND TIME 
or DT 

- -

DWORD 

BLOCK FB 

BLOCK FC 

INT 

POINTER 

REAL 

STRING 

BLOCK SDB 

STRING[n] 

TIME OF DAY 
or TOD 

TIME 

TIMER 

S5TIME 

WORD 

Designation Bits 

Pointer to data element 80 

Logical value 1 

8-bit sequence 8 

Individual character 8 

Number of an S7 counter 16 

Date 16 

Number of a DB 16 

Double integer 32 

Date and time 64 

32-bit sequence 32 

Number of an FB 16 

Number of an FC 16 

Integer 16 

Pointer to memory area 48 

Floating-point number 32 

ASCII string 254 bytes 

Number of an SDB 16 

String o f  up t o  n characters, 1 ::s n ::s 253 n bytes 

Time 

Duration 

Number of an S7 timer 

Duration in S5 format 

Sequence of 16 bits 

32 

32 

16 

16 

16 
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List of abbreviations 

C ! C++ High-level language for programming computers 

CFC Continuous Function Chart 

COM Setup /Commisioning 

CPU Central Processing Unit 

cs Control System 

csv Comma-Separated Values (file format) 

DB Data Block 

ES Engineering System 

FB Function Block 

FC Function Code (function block without memory) 

lEA Import/Export Assistant 

LAD LAdder Diagram 
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List of abbreviations 

MS 

08 

OP 

O&M 

OS 

PC 

PG 

PH 

PICS 

PLC 

SFB 

SFC 

SFC 

SINEC 

STEP 7 

STL 

8-2 

Microsoft 

Organization Block 

Operator Panel 

Operating and Monitoring (WinCC) 

Operator Station 

Personal Computer 

Programming device 

Plant hierarchy 

Process Instrumentation and Control System 

Programmable Logic Control I Automation System 

System Function Block 

Sequential Function Chart 

System Function Call 

Siemens NEtwork ArChitecture 

Software development environment for SIMATIC S7 I M7 

STatement List 
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G lossary 

A 

Access 

Action 

Address 

Addressing, 
absolute 

Addressing, 
symbolic 

Alternative branch 

Operands, charts, block I/Os and runtime groups can be accessed from chart 
elements or block I/Os. It is also important to differentiate between read and 
write access. 

(SFC) actions are used to activate or deactivate runtime groups and main 
SFCs and to modify blocks and global resources by assigning to their input 
parameters. The actions are formulated by means of formatted dialog in 
zoom-in mode. 

An address is the designation of a certain operand or range of operands. 
Examples include: Input I 12.1; flag word MW25; data block DB3. An 
address may be declared as absolute or symbolic. 

With absolute addressing. the operand contains the memory address of the 
value to be used by the operation. Example Address A 4.0 designates bit 0 in 
byte 4 of the process image output table (PIO). 

With symbolic addressing, the operand to be used is given a symbol (rather 
than an address). The symbols and addresses are assigned to one another via 
the symbol table. 

(SFC) structure element consisting of at least two transition sequences, only 
one of which is executed by the PLC when its first transition condition is 
fulfilled. 
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Glossary 

Automation 
system 

Auto router 

B 

Basic element 

Basic operation 

Bit memory (M) 

Block 

Block header 

Block input 

Block 1/0 

Glossary-2 

An automation system is a programmable logic controller (PLC) for a 
SIMPJIC S7, a high-performance device (PLC with integrated operator 
panel) SIMATIC C7, or an automation computer SIMATIC M7. 

(CFC) program segment for automatically creating connecting lines, 
connectors and marginal entries. 

(SFC) The basic elements of a chart are the "step" and the "transition". To 
guarantee identification, the name of each element must be unique within the 
chart. 

Basic operations are objects which can exist at any time within the system 
and contain simple calculation functions such as AND, OR, etc. 

Memory area in the system memory of a SIMATIC S7 CPU. It allows both 
read and write access (by bits, bytes, words and double words). The bit 
memory address area can be used by the user to store interim results. 

Blocks are discrete segments of the user program delimited by their function, 
structure or application. 
The CFC works with predefined block types which are positioned in (inserted 
into) control system flowcharts. When a block type is inserted, an instance of 
this block type is generated. These instances and their graphical 
representations are blocks for the purposes of CFC. 

The top part of the block in the CFC display. It contains, for example, the 
names and task assignment (runtime properties). 

A block 1/0 which can be linked to a block output and operands of the same 
data type or assigned values. 

A block input or output 
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Block output 

Block type 

c 

CFC 

CFC editor 

Chain 

Chart 

Chart container 

Chart element 

Chart topology 

Glossary 

A block 1/0 which can be linked to block inputs and operands of the same 
data type. 

Block types are predefined program sections which can be inserted into a 
CFC chart, generating instances in the process. Any number of instances can 
be created from a block type. 
For an S7 PLC, the block types are created with LAD, STL or SCL. 

Continuous Function Chart. A control system flowchart with 
graphically-linked plant-related functions (blocks). 

A configuration tool enabling continuous processes to be described in a 
user-friendly mannerThe editor is used to create control system flowcharts in 
which blocks can be assigned parameters and linked. 

(SFC) A chain is a sequence of chart elements (a vertical path within the 
chart topology). A parallel or alternative branch consists for example of 2 to 
n parallel chains, each with 1 to n basic elements. 

A special graphics unit created with the CFC or SFC configuration tool. A 
chart has an implicit type, but no interface. This means that it cannot be 
interconnected. 

A chart with 
graphically linked plant-related functions (CFC), 

- graphical display of a plant-related sequential control system (SFC) 

Container in the project structure, contains the charts of a user program. 

(SFC) Chart elements are divided into two groups: basic elements (step, 
transition, text) and structure elements (sequence, parallel branch, alternative 
branch, loop). 

(SFC) In the chart topology, the chart elements are displayed in accordance 
with fixed syntax rules (e. g. distances between, spread and alignment of the 
elements). The syntax rules are observed automatically by the editor when 
the chart creates the chart topology. 
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Glossary 

Chart overview 

Code block 

Code generation 

Commissioning 
(COM) 

Compilation 

Connector 

Consistency check 

Counter (C) 

Create mode 

Glossary-4 

The overview of a CFC chart with its six sheets. 

In SIMATIC S7, a code block is a block containing part of the STEP 7 user 
program. In contrast a data block only contains data. The following code 
blocks exist: 

• Organisation blocks (OB) 

• Function blocks (FB) 

• Functions (Fq 

• System function blocks (SFB) 

• System functions (SFq 

Compilation of the graphical CFC to create an application program (SCL for 
S7 or C for M7). 

Testing functions are incorporated CFC /SFC editor to support 
commissioning and to monitor, change and, if necessary, to adjust setpoint 
values as the programs run on the PLC. 

Creates an executable user program from a source. 

(CFq Point of connection on the block with a reference to the 1/0 to be 
linked. Connectors are used if no further connecting lines can be drawn on a 
sheet because it is too full. The connectors also enable complex CFC 
structures (covering more than one sheet) to be displayed in full. 

Checks that the block types, shared operands, etc of the chart container are 
consistent. 

Counters are part of the system memory of the CPU. The contents of this 
counter can be changed by STEP 7 statements (for example count up, down). 

(Alternative to test mode) 
Enables blocks to be inserted, deleted, renamed, assigned parameters or 
linked in the CFC. 
In SFC, it is used to create a sequential control system. Chart elements can 
be inserted, deleted, moved, renamed and assigned parameters in the zoom 
view. 
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D 

Data block (DB) 

Data type 

Diagnostic buffer 

Display property 

OM variable 

Dynamization 

E 

Enable attribute 

Glossary 

Data blocks are data areas in the user program which contain user data. There 
are shared data blocks which can be accessed by all code blocks, and 
instance data blocks which are assigned to certain FB calls. In contrast to all 
other blocks, they do not contain statements. 

A data type defines how the value of a variable or constant can be used at a 
block 1/0. For example, "BOOL" defines a binary variable and "INT" 
defines a 16-bit fixed-point variable. 

Backed-up memory area in the CPU in which all the diagnostic events are 
saved in their sequence of occurrence. 

(CFC) An attribute at the block 1/0 which determines whether the block 1/0 
is displayed (visible) in the CFC or not. 1/0s which have been linked are no 
longer visible. 

Data manager variable in WinCC 

Dynamization means that input or initial values of a block from the CPU ares 
updated in the CFC chart running in test mode. 

The enable attribute is an execute property. It switches a runtime group on or 
off. As long as it is deactivated, the group is not executed, irrespective of all 
other conditions. 
The enable attribute can be set dynamically. The initial value of a CFC block 
then determines whether the group is switched on or off. 
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Glossary 

F 

Function (FC) 

Function block 
(FB) 

G 

Generic block 

Generic property 

H 

Higher level 
designation (HID) 

HOLD mode 

Glossary-6 

(FUNCTION) Functions are code blocks w i t  h o u t a memory as defined 
in IEC 1131-3. A function offers the possibility of transferring parameters in 
the user program. Functions are therefore suitable for programming complex 
functions occurring repetitively, such as calculations. Important: Since a 
memory does not exist, the calculated values must be used immediately after 
the FC call. 

(FUNCTION BLOCK) A function block is a code block with static data as 
defined in IEC 1131-3. A function block offers the possibility of transferring 
parameters in the user program. This makes function blocks suitable for 
programming complex functions recurring repetitively such as controls, 
mode selection. Since an FB has a memory (instance data block), is 
parameters (for example outputs) can be accessed at any time at any point in 
the user program. 

(CFC) A block, the number of inputs of which can be modified by parameter 
assignment. 

(CFC) A block with the generic property has a variable number of inputs, 
i. e. in the CFC, the user can increase the number of inputs or reduce it to the 
original number. 

Formed from the path of the plant hierarchy. 

HOLD mode is activated from RUN mode by a request from the 
programming device. Special test functions can be used in this operating 
mode. 
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lmport/-Export 
Assistant (lEA) 

Instance 

Interconnection 

Interrupt stack 

L 

Ladder Logic 
(LAD) 

Library 

Load-related 
change 

Local data 

Loop 

Glossary 

This is a software block in the ES for handling templates and their instances 
(PICS units) 

A block type which has been selected and inserted into a chart becomes an 
instance. When it is inserted runtime properties are assigned to the instance 
and a name which is unique within the chart is assigned. 

(CFC) Linking a block output or block input to another element. The value of 
the linked input will be fetched from the other end of the connection at run­
time. The following interconnections are possible: 

Block output � Block input 
Block output � Shared operand 
Block output � Runtime group 
Shared operand � Block input 

In the case of an alarm or error, the address of the interrupt location with the 
current display is entered by the CPU in the interrupt stack (I stack) of the 
system memory of the CPU. 

Graphical representation of the automation task with symbols from the DIN 
19239 circuit diagram. 

A container for reuseable projects and objects. 

A change to the CFC/SFC chart is load-related if it causes the CPU user 
program to change (e. g. interconnection changed). Non load-related changes 
concern, for example, block positions and comments in the CFC. 

Local data is the data assigned to a code block and listed in its declaration 
section or its variable declaration. 

(SFC) Structure element consisting of a sequence (S sequence) and a return 
branch enclosing the S sequence, and containing precisely one transition. 
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Glossary 

M 

Margin 

Memory reset 

Message class 

Message planning 

MPI address 

Multi Point 
Interface {MPI) 

0 

Operating mode 

Operating mode 

Glossary-a 

( CFC) Box on the left and right edges of a sheet. The margins contain 
a) references to linked objects (block, BOP, run-time group) not on the 
current sheet; 
b) the number of the connector reference if the autorouter could draw the line 
right to the margin because the chart was too full. 

During a memory reset the following memories of the CPU are deleted: 

• Working memory 

• Read-/Write-area of the load memory 

• System memory with the exception of the MPI parameters and the 
diagnostic buffer 

The message class determines the property of the message. SIMATIC PCS 7 
has the following message classes: alarm, warning, tolerance, PLC and OS 
status message, process message, operator request and operator message. 

Creating messages with their attributes and texts. Messages can be planned 
from the CFC/SFC. 

In an MPI network, each programmed module must be assigned a separate 
MPI address. 

interface for connecting up to 32 devices (PC, PG, programmable controller, 
PLC). 

The SIMATIC S7 process logic controls have the following operating modes: 
STOP, STARTUP, RUN and HOLD. 

The mode selector of the central processor is used to set the following 
operating modes: 

• RUN with the option of accessing the STEP 7 user program 
from the programming device, for example ("RUN-P"). 

• RUN with access protection ("RUN"), 

• STOP and 

• Memory reset ("MRES"). 
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Operating system 

On-line/off-line 

Operand 

Organization block 
(OB) 

Overflow page 

p 

Parameter 

Phase offset 

Plant hierarchy 
(TH) 

Glossary 

Comprehensive term for all functions which, in conjunction with the 
hardware, control and monitor the execution of user programs, the allocation 
of system resources to individual user programs and maintenance of the 
operating mode (for example (the MS WINDOWS standard operating 
system, M7 RMOS32 real-time operating system). 

In on-line mode a data connection exists between the programmable logic 
controller and the programming device, in off-line mode it does not. 

An operand is part of ar STEP 7 instruction and defines what the processor is 
to use to do something. It can be addressed in absolute form or symbolically. 
In the SFC, an operand is part of an assignment (step) or condition 
(transition). 

In an S7 organization blocks form the interface between the operating system 
of the CPU and the user program. The execution sequence of the user 
program is defined in the organization blocks. An organization block 
corresponds to a task. 

(CFC) An overflow page is automatically created if so many marginal entries 
have been created that there is no space remaining. An overflow page 
consists only of the margins and contains no other objects. 

A parameter is 
1 .  a variable of an S7 code block (actual parameter, formal parameter) 
2. a variable for defining the behavour of a module. Every module for which 

parameters can be assigned is delivered with a meaningful basic setting 
that can be changed using STEP 7. 

The phase offset moves the point at which the runtime group or chart is 
activated, within a task, by a pre-defined value compared to the basic cycle. 
This ensures even load distribution within the CPU. 

A structure divided up hierarchically on the basis of the equipment contained 
in it. 
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Glossary 

PLC 

Process image 

Process variable 

Processing phase 

Program 

Programming 
device 

Project 

R 

Reference data 

Resources 

RUN mode 

Runtime attribute 

Glossary-1 0 

The programmable logic controller or a component of it on which the user 
program runs. PLCs are for example the SIMATIC S7 and M7. 

Reserved areas in the CPU RAM. The signal states of the input and output 
modules are stored in it. 

This is a resource-neutral object. It is used to link the PLC programming 
environmment (STEP 7, CFC, etc.) to the OS programming environment 
(WinCC). It contains information on the location at which it exists at runtime 
(e. g. the network address in the PLC) and information on specific OS-related 
properties. 

(SFC) A step is divided into three processing phases: Initialization, (cyclic) 
processing and termination. Each processing phase corresponds to an action 
with assignments. 

Generic term for S7 and M7 programs. 

Portable personal computer with a special robust and compact design. A 
programming device is equipped completely to program SIMATIC 
programmable logic controllers. 

A container for all the objects of an automation solution irrespective of the 
number of stations, modules and their networking. 

Reference data are data which are available to the user in the form of lists in 
addition to the graphical data display, for example a list of the accesses to the 
shared addresses. 

Resources are sets of objects (FB, FC, DB, OB, flags, counters, timers, etc) 
which can be accessed when configuring and assigning parameters to a 
CFC/SFC chart. 

In RUN mode, the user program runs and the process image is cyclically 
updated. All the digital outputs are enabled. 

Each runtime group has runtime attributes which control its activation. The 
group passes on these properties to all the blocks contained in it. 
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Runtime group 

Runtime 
properties 

s 

S7 program 

Scan rate 

Scan time 

SCL 

Sequence 

SFC 

Shared address 

Glossary 

Runtime groups are used to structure and classify tasks. The blocks are 
installed sequentially in the runtime groups. Runtime groups can be activated 
and deactivated separately. When a runtime group is deactivated, all the 
blocks contained in it are deactivated as well. 

The runtime properties of a block defines how this block fits into the running 
order within the overall structure of the PLC. These properties determine the 
behaviour of the PLC with respect to response times, down times or the 
stability of time-critical systems, e. g. closed-loop control circuits. 

A container for blocks, sources and charts for programmable S7 modules. 

The scan rate is a runtime property. It determines whether a chart or a 
runtime group is to be processed whenever the task is passed through or only 
on the nth pass. 

The scan time is the time required by the CPU to execute the user program 
once. 

A Pascal-like high-level language confirming to IEC 1131-3 for 
programming complex tasks in a PLC, e. g. algorithms, data processing 
system. 

(SFC) A structure element containing a series of steps (S) and transitions (T). 
There are four different types of sequences which are characterized by the 
first and last type of the chart element: S, T, ST and TS sequences 

An SFC represents a sequential control system which is executed as an 
autonomous control system in the programmable logic controller. 

Shared addresses are objects which can be accessed by every code block (FC, 
FB, OB). Shared addresses are bit memories (M), inputs (1), outputs (Q), 
timers (T), counters (Z) and elements of data blocks (DBs). Shared addresses 
can be accessed either absolutely or symbolically. 
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Glossary 

Shared data block 

Sheet 

SIMATIC Manager 

Source 

STARTUP 

STARTUP mode 

Statement list 
(STL) 

Step 

Glossary-1 2 

This is a block which can be accessed by all the blocks in the program. Every 
CFC block instance can read the shared data from such a block or write data 
to the block. 
Shared data blocks are created using the LAD or STL Editor. 

(CFC) Part of a chart. A workspace with margins on which the blocks can be 
positioned and linked. 

Graphical user interface for SIMATIC users under Windows 95. The 
SIMATIC Manager is used for example to create projects and to access 
libraries. 

Segment of a program which is created with a graphical or text editor and 
from which the executable S7 user program is created by compiling. 

Startup is an operating mode through which the CPU passes during the 
transition from STOP to RUN mode. STARTUP is triggered when the mode 
selector on the CPU is selected, after power-on or by operation on the 
programming device. 

The CPU passes through startup mode when it switches from STOP mode to 
RUN mode. It can be triggered with the mode selector, by switching the 
power on from the programming device. On the S7-300, this means a cold 
restartOn the S7-400, it can be either a cold restart or a warm restart, 
depending on the position of the mode selector. 

The statement list is a low-level, text-based programming language. The 
representation form for STL is the STEP 5 and STEP 7 assembly language. 
When a program is programmed in STL, then the individual statements 
correspond to the steps with which the CPU runs the program. 

(SFC) A step consists of a basic element and the control instance for 
processing the actions assigned to it. Each step consists of three actions: 
Initialization, (cyclic) processing and termination. 
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Step control 

Step group control 
(SGC) 

Step types 

Step zoom-in 

STOP mode 

Structure element 

(SFC) Operating mode with the following switching modes: 

• SWA (Stepping with acknowledgment) 
Sequential control is operator-controlled. 

• scr (step control with transition) 
The sequential control system is controlled by the process. 

• scroc (step control with transition or confirmation) 

Glossary 

The sequential control system is controlled by the process or by the 
operator. 

• SCTAC (step control with transition and confirmation) 
The sequential control system is controlled by the process and by the 
operator. 

(SFC) Operating mode with switching mode "SGC". For steps without an 
SGC flag, the sequential group control is controlled by the process (as with 
SCT) and for steps with an SGC flag, it is controlled by the operator (as with 
SCTAC) 

(SFC) The SFC supports different step types: 

• Starting step 

• Normal step 

• End step 

(SFC) See zoom in 

STOP mode is initiated by: 

• switching the mode selector 

• an internal error on the central processing unit 

• operator input on the PC/programming device 

The user program is not executed in STOP mode. All the modules are 
switched to a secure state. Certain programming functions such as operator 
communication, visualization and monitoring functions can also be used. 

(SFC) Structure elements consist of an arrangement of basic elements. The 
following are structure elements: "Sequence", "parallel branch", "alternative 
branch" and "loop". 
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Glossary 

Symbol 

Symbol table 

T 

Task 

Test mode 

Timer (C) 

Transition 

Transition zoom-in 

Glossary-14 

A symbol is a name defined by the user under observation of certain syntax 
rules. This name can be used for programming as well as for operating, 
visualization and control after you have defined its use (for example variable, 
data type, jump label, block). 
Example Address: I 5.0, Data type: BOOL, Symbol: Emergency stop 
pushbutton. 

Table used to assign symbols (=name) to addresses for shared data and 
blocks. 
Examples: Emergency stop (symbol), 

I 1 .7 (address), 
Controller (symbol), 
SFB 24 (block) 

Tasks are the interface between the CPUs operating system, and the user 
program. The Order in which the user program is executed is defined in the 
task. A task corresponds to an OB (S7). 

(Alternative to Create mode) CFC/SFC operating mode for testing and 
optimising the user program running online on the CPU. 

Timers are part of the system memory of the CPU. The contents of these 
timers are updated by the operating system asynchronously to the user 
program. STEP 7 statements are used to define the exact function of the 
timer (for example on-delay and to trigger their execution (start). 

(SFC) A transition is a basic element containing the conditions under which a 
sequential control system is allowed to move on from one step to the 
following step. 

(SFC) See zoom-in 
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u 

Updating cycle 

User program 

v 

Variable 

w 

Warm restart 

z 

Zoom 

Zoom in 

Glossary 

In test mode, this defines the intervals at which the monitored block 1/0s are 
updated. 

The user program contains all the instructions, declarations and data required 
to process signals in order to control a plant or process. It is assigned to a 
programmable module (for example CPU, FM) and can be structured in 
smaller units. 

A variable defines a data item with variable contents which can be used in 
the STEP 7 user program. A variable consists of an address (for example M 
3 .1) and a data type (for example BOOL) and can be characterized by a 
symbol (for example BELT_ ON). 

(S7) When a central processing unit starts up (for example when the mode 
selector has been switched from STOP to RUN or when the supply voltage is 
switched ON), cyclic program scanning (OBl) first executes either the 
organization block OB 100 (cold restart) or the organization block (OBlOl) 
(warm restart, only for S7-400). When the system is restarted, the process 
input image is uploaded and processing of the STEP 7 user program is 
continued from the point at which it ended at the last interruption (STOP, 
power off). 

(SFC) In the zoom display, the steps and transitions of the sequential control 
system still run (actions and conditions are created). 

(SFC) see: zoom-in view 
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I ndex 

A 

Additional documents, 3-6 
Alarm block, 5-9 
Assignment OS/PLC, 3-8 

B 

Block types, 5-12, 5-14 

c 
CFC in the PH, 3-10 
Component view, 1-5 
Configuring OS, 5-4 
Creation of block types, 5-14 
Cross references 

Addresses, 6-5 
Block types, 6-7 
CFC 1/0s, 6-6 
Runtime groups, 6-6 
S7 resource assignment, 6-8 
SFC, 6-7 

CS engineering, 1-10 
CSV file, 4-10 

D 

Device-independent, 1-7 
DM variable, 5-4 
DM variables, 1-7 
Documentation prefix, 3-6 
Driver blocks, 5-12 

E 

Edit, 4-3 
Engineering phases, 1-8 
Engineering system, 1-7 
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Export, 4-3, 4-14 
Export file, 4-16 

F 

Formal parameter, 5-8 
Functional unit, 1-10, 4-10 

H 
HID, 1-6, 3-5 
Hierarchical level, 3-6 
Hierarchy container, 3-3 
Higher level designation, 1 -6, 3-7 
Higher-level designation, 3-6 

Identifier formation, 3-6 
Import, 4-3, 4-10 

L 

Leaf object, 3-3 
leaf object, 1-4 

Log file, 4-20 
Log window, 4-9 

M 

Message, 5-8 
Message instance, 5-7 
Message number, 5-9 
Message planning, 5-7 
Message type, 5-7 
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Index 

N 
Naming convention, 3-5 

0 

Object properties, special, 5-3 
OS area identification, 3-7 
OS assignment, 3-9 

p 
Parameter description, 4-18 
Parameter 1/0 point, 4-2 
phase-independent, 1-8 
Place of use, 6-3 
Plant hierarchy, 1-5, 3-4 
Plant planning, 1-10 
Plant view, 1-5 
PLC - OS link configuration, 5-2 
PLC assignment, 3-8 
print, reference data, 6-3 

R 

Reference data, 6-2 
Run Sequence, 6-9 

s 
S7_a_type, 5-21 
S7 _ blockview, 5-18 
S7_dynamic, 5-19 
S7_1ink, 5-19 
S7_m_c, 5-20 
S7 _param, 5-19 
S7_server, 5-20 

lndex-2 

S7 _shortcut, 5-21 
S7 _string_O, 5-22 
S7 _string_1, 5-22 
S7_tasklist, 5-18 
S7 _unit, 5-21 
S7 _visible, 5-18 
SFC in the PH, 3-10 
Signal description, 4-19 
Signal 1/0 point, 4-2 
Specimen solutions, 1 -10, 4-11 
Standard hierarchy, 1 -5, 3-4 
Stock of variables, 5-4 
System properties, 5-17 

T 

Text library, 5-25 
Transfer configuration data, 5-11 
Transfer to the OS, 5-4 

u 
User interface (lEA), 4-6 

v 
View 

device-oriented, 1-5 
plant, 1-5 

Visualize SFC, 5-10 

w 
WinCC, 5-10 
WinCC properties, 5-6 
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Siemens AG 

AUT E 146 

Ostliche Rheinbriickenstr. 50 
D-761 8 1  Karlsruhe 

Federal Republic of Germany 

From: 

Name: Your 

Your 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - -

Title: 

Company Name: 

Street: - - - - - - - - - - - - - - - - - - - - - - - - - -

City, Zip Code _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _  _ 

Country: 

Phone: 

Please check any industry that applies to you: 

0 Automotive 

0 Chemical 

0 Electrical Machinery 

0 Food 

0 Instrument and Control 

0 Nonelectrical Machinery 

0 Petrochemical 
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0 Pharmaceutical 

0 Plastic 

0 Pulp and Paper 

0 Textiles 

0 Transportation 

0 Other _ _ _ _ _ _ _ _ _ _ _ 
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Remarks Form 

Your comments and recommendations will help us to improve the quality and usefulness 
of our publications. Please take the first available opportunity to fill out this questionnaire 
and return it to Siemens. 

Please give each of the following questions your own personal mark within the range 
from 1 (very good) to 5 (poor) . 

1 .  
2. 

3. 
4. 

5. 

Do the contents meet your requirements? 

Is the information you need easy to find? 

Is the text easy to understand? 

Does the level of technical detail meet your requirements? 

Please rate the quality of the graphics/tables: 

D 
D 
D 
D 
D 

Additional comments: 

2 
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